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Copyrights and Trademark Notices
Telestream. Copyright © 2021 Telestream, LLC and its Affiliates. All rights reserved. No 
part of this publication may be reproduced, transmitted, transcribed, altered, or 
translated into any languages without written permission of Telestream, LLC. 
Information and specifications in this document are subject to change without notice 
and do not represent a commitment on the part of Telestream. Specifications subject to 
change without notice.

Telestream, CaptionMaker, Cerify, DIVA, Episode, Flip4Mac, FlipFactory, Flip Player, 
GraphicsFactory, Kumulate, Lightspeed, MetaFlip, Post Producer, ScreenFlow, Switch, 
Tempo, TrafficManager, Vantage, VOD Producer, and Wirecast are registered trademarks 
and Aurora, ContentAgent, Cricket, e-Captioning, Inspector, iQ, iVMS, iVMS ASM, 
MacCaption, Pipeline, Sentry, Surveyor, Vantage Cloud Port, CaptureVU, FlexVU, PRISM, 
Sentry, Stay Genlock, Aurora, and Vidchecker are trademarks of Telestream, LLC and its 
Affiliates. All other trademarks are the property of their respective owners. 

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 Adobe Systems. All rights 
reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

CoreOS. Developers of ETCD.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby 
Laboratories Licensing Corporation.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights reserved.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

MCW. HEVC Decoding software licensed from MCW.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
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WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows NT|2000|XP|XP Professional|Server 2003|Server 2008 
|Server 2012|Server 2016|Server 2019, Windows 7, Windows 8, Windows 10, Media 
Player, Media Encoder, .Net, Internet Explorer, SQL Server 2005|2008|2012|2016|2019, 
and Windows Media Technologies are trademarks of Microsoft Corporation.

NLOG, MIT, Apache, Google. NLog open source code used in this product under MIT 
License and Apache License is copyright © 2014-2016 by Google, Inc., © 2016 by Stabzs, 
© 2015 by Hiro, Sjoerd Tieleman, © 2016 by Denis Pushkarev, © 2015 by Dash Industry 
Forum. All rights reserved.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Swagger. Licensed from SmartBear.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge Corporation.

x264 LLC. The product is manufactured by Telestream under license from x264 LLC.

Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.
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ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

 

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.
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MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.
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Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream during U. S. business hours via telephone at (530) 470-1300.

Regulatory Compliance
Electromagnetic Emissions: FCC Class A, EN 55022 Class A, EN 61000-3-2/-3-3, CISPR 22 
Class A

Electromagnetic Immunity: EN 55024/CISPR 24, (EN 61000-4-2, EN 61000-4-3, EN 
61000-4-4, EN 61000-4-5, EN 61000-4-6, EN 61000-4-8, EN 61000-4-11)

Safety: CSA/EN/IEC/UL 60950-1 Compliant, UL or CSA Listed (USA and Canada), CE 
Marking (Europe)

California Best Management Practices Regulations for Perchlorate Materials:
This Perchlorate warning applies only to products containing CR (Manganese Dioxide) 
Lithium coin cells. Perchlorate Material-special handling may apply. See 
www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Before You Install Vantage

Use this topic to understand and plan for the hardware, software, database, and 
network requirements before performing an installation. You’ll also learn about 
Vantage installers, how to obtain a Vantage license, and some distributed Vantage 
domain planning advice—this topic is about what you need to know before you install 
a Vantage domain.

Installing Vantage is easiest when you plan carefully, and you have a working 
knowledge of Windows server administration, networking, Microsoft SQL Server, and 
installation and configuration of enterprise-class software. Consult your IT group for 
assistance as necessary.

Note: Go to www.telestream.net/telestream-support/vantage/support.htm to 
browse the Vantage Web library, user guides, patches, application notes, and other 
documents.

The following topics provide information you should consider when planning a 
Vantage installation:

■ Server Hardware Requirements

■ Operating System Requirements

■ Third-Party Software Requirements

■ Network Requirements

■ Database Selection and Configuration Guidelines

■ Vantage Installers Overview

■ Licensing Overview

■ Planning for a Vantage Array Installation

http://www.telestream.net/telestream-support/vantage/support.htm
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Server Hardware Requirements
Vantage is optimized for multi-core processors that support Windows operating 
systems. The following topics provide more information on Vantage server hardware 
requirements:

■ Ensure Maximum Server Performance

■ Vantage Server Requirements

■ Database Server Requirements for SQL Standard

Ensure Maximum Server Performance
To ensure maximum server performance for all servers in the Vantage domain, be sure 
to set the Control Panel Power Options as follows:

Set the Power Options to High Performance with Sleep disabled:

1. Navigate to Start > Control Panel > Power Options.

2. Select the High Performance plan. 

3. Set Sleep mode to Never (never sleep).

4. Select Change advanced power settings, and set all critical functions so that they are 
always ON (this usually means setting them to Never turn OFF).

■ Also disable any real-time processes that may interfere with performance, such as 
virus scanning of media files as they are being captured, automatic real-time soft-
ware updates, and real-time file indexing.
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Vantage Server Requirements
Vantage server requirements depend on which domain components (services, media 
files, and database) are installed on the server, as well as how much media you plan to 
store on the server. The following table lists the hardware requirements for servers that 
host Vantage and SQL Express database services.

Database Server Requirements for SQL Standard
Correctly specifying the hardware and planning the database is crucial for optimal 
Vantage system operation. For hardware requirements and other guidelines for a SQL 
Standard database, please refer to the Planning and Managing a Vantage Database 
chapter and these specific topics before you install Vantage or the database:

■ Operating System Requirements

■ Database Server Requirements for SQL Standard

■ Guidelines for Selecting SQL Express or SQL Standard

Hardware Requirements

Processor 64-bit dual six-core processors or greater; 8 MB cache or 
greater recommended.

RAM At least 16GB RAM or greater recommended, depending on 
the number of concurrent transcode sessions desired. 

Disk space All-in-one installations: 500 GB; approximately 1 GB for 
Vantage services and clients, approximately 500 MB for the 
Transcode and Analysis Engine, and approximately 400 GB for 
the Vantage store media and database. The initial database size 
is approximately 100 MB.

Ethernet/Fibre All-in-one installations: Gigabit Ethernet (GbE / 1 GigE) 
minimum. (Dual Ethernet may be needed in some situations). 

Vantage arrays: Gigabit Ethernet (GbE / 1 GigE) minimum. 
Recommend dual bonded Ethernet or 10GigE. The Vantage 
domain database and all Vantage services should be on the 
same subnet.

Numeric Processing 
Instruction Set

 MMX, SSE, and SSE2 enabled.
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Operating System Requirements
The following topics describe the operating system requirements for Vantage 
components:

■ Vantage Web Applications OS

■ Vantage Client Software OS

■ Vantage Services, Domain Database, and MS SQL Server OS

Note: Automatic Windows and software updates and automatic restarts of Vantage 
servers should be disabled. Schedule update installations and system restarts only 
during planned maintenance periods to prevent disruption of Vantage operations. 

Note: Operating System support presented here is current at the time of publication. 
However, updates to supported Operating Systems may occur. Verify that the server 
on which you plan to install Vantage meets the platform requirements, as specified at 
telestream.net/vantage/tech-specs.htm. 

Vantage Web Applications OS
Vantage Web Applications should be installed on an IIS server running on the same 
subnet as the Vantage domain database, so that the Web applications can auto-
discover the Vantage domain. To improve the performance of Vantage Web 
Applications and Vantage services, place the Vantage Web Applications on a dedicated 
server, separate from the Vantage domain database and Vantage services. The 
following list ranks the possible Vantage Web Application configurations from most 
preferred (#1) to least preferred:

1. Dedicated Vantage Web Application server.

2. Vantage Web Applications installed on a Vantage domain database server that 
does not host Vantage services.

3. Vantage Web Applications installed with the Vantage domain database and 
Vantage services on the same server (includes all-in-one domains).

Vantage Web Applications should only be installed and operated on the following 
operating systems:

• Windows Server 2012 R2 (64-bit only)

• Windows Server 2016 (64-bit) Standard or Data Center Edition

• Windows Server 2019 (64-bit) Standard or Data Center Edition

• Microsoft IIS 8.0 or later is required. 

• .NET 4.8 is required. 

Installation of the IIS and .NET components is covered as part of Web app installation in 
the next chapter: Installing and Configuring Vantage Web Applications. The Web Apps 
installer now installs .NET 4.8 for you automatically if it is not already present.

https://www.telestream.net/vantage/tech-specs.htm
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Vantage Web Applications Browser Requirements
Telestream supports the following browsers for use with the Vantage Web applications: 

• Internet Explorer 11, 32-bit or 64-bit (Windows only)

• Chrome current version (Mac OS X & Windows)

• Safari current version (Mac OS X only)

Note: To use Vantage Web applications with Internet Explorer, you must configure 
Internet Explorer as described below. Also note that Firefox is not recommended 
because it does not allow previewing in the Web Workflow Portal on Windows Server 
systems.

Note: Supported browsers for Lightspeed Live Capture may differ slightly from those 
listed above. Consult the Live Capture User Guide published on the Telestream 
website for current requirements. 

To configure Internet Explorer for use with Vantage Web applications, do the following:

• Enable Active Scripting—Open Internet Explorer, select Tools > Internet options, 
select the Security tab, click Custom level, scroll down to Scripting, click the Active 
scripting Enable radio button, click OK, and click OK.

• If you are using Internet Explorer on a Windows Server operating system, disable 
Enhanced Security Configuration (ESC) using the Windows Server Manager (Server 
Manager > Security Information > Configure Internet Explorer ESC).
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Vantage Client Software OS
Vantage client programs (Vantage Management Console, Vantage Workflow Designer, 
and Vantage Workflow Portal) may be installed and run directly on a Vantage server, or 
on client workstations.

Vantage client programs are supported on the following operating systems:

• Windows 7, 8.1, and 10 (all versions may be x86 or x64)

• Windows Server 2012 R2

• Windows Server 2016 (x64 with Desktop Experience) Standard or Data Center

• Windows Server 2019 (x64 with Desktop Experience) Standard or Data Center Edi-
tion

Note: To effectively operate Vantage services and their client programs in an array, 
and with other networked systems, you must disable the Windows Firewall and 
upgrade all systems to the latest Microsoft service packs and security updates.

Vantage requires Windows Desktop Experience (see Install the Desktop Experience). 

Note: Desktop Experience is required so that the Vantage transcoders, clients, and 
preview player can function correctly.

If you connect to the server using a Remote Desktop Protocol (RDP) product, you must 
also install the Desktop Composition role feature. 

Once Desktop Composition is installed, you must also enable the Desktop Composition 
policy. 

Note: If you cannot install or enable Desktop Composition because needed options 
are grayed out, group policies set by your IT administrator may be preventing access. 
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Vantage Services, Domain Database, and MS SQL Server OS
Vantage services, the Vantage Domain Database, and the MS SQL Server for Vantage 
should be installed and operated only on the following operating systems (64-bit 
recommended for performance):

• Windows Server 2012 R2 (x64 only)

• Windows Server 2016 (x64 with Desktop Experience) Standard or Data Center Edition

• Windows Server 2019 (x64 with Desktop Experience) Standard or Data Center Edi-
tion

All Vantage services and Telestream core services have been qualified on Windows 
Server 2012 R2, Server 2016, and Server 2019 except as noted below: 

• Avid AAF Encoder—Qualified on Server 2012 R2 only. 

• Screen MediaMate—Tested and deployed by Screen; see Screen’s documentation.

For all third party Vantage services (besides Aspera), refer to the respective third party 
manufacturer’s documentation for supported operating systems. 

Windows Server Configuration Requirements
The following topics describe additional Windows requirements for Vantage:

■ Install the Desktop Experience

■ Windows Server 2012 R2 Desktop Experience

■ Understand User Account Control Admin Approval Mode

■ Power Options Settings

Install the Desktop Experience

Prior to installing Vantage, the Microsoft Desktop Experience must be installed on 
Vantage servers (except dedicated database servers) for Vantage clients and services. 
The Desktop Experience feature provides Windows 7 features on your server and is 
required by several actions, including the Analyze, Conform, Timed Text, and various 
Flip actions as well as Vantage clients and the proxy preview player. 

To install the Windows Desktop Experience follow the procedure below for your OS.

Windows Server 2016 Desktop Experience

When you install Windows Server 2016, you can choose “Windows Server (Server with 
Desktop Experience).” This installs the Desktop Experience along with the server OS. No 
additional installation steps are required.
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Windows Server 2012 R2 Desktop Experience

You can use either Windows PowerShell or the Server Manager to install Desktop 
Experience for Windows 2012, as explained below. 

To install Desktop Experience on Windows Server 2012 R2 using Windows PowerShell:

1. Press Start.

2. Type: PowerShell.

3. Right-click PowerShell.

4. Select Run as administrator.

5. Execute this command:
Install-WindowsFeature Desktop-Experience

To install Desktop Experience on Windows Server 2012 R2 using the Server Manager:

1. Launch Server Manager.

2. In the left-hand column, go to Local Server.

3. Scroll down to ROLES AND FEATURES.

4. Left-click the TASKS button and select Add Roles and Features (see the figure below). 
The Add Roles and Features Wizard window opens.

5. Click Next four times until you arrive at the Features page.

6. On the Select feature page, expand the User Interfaces and Infrastructure group and 
enable the Desktop Experience check box. Then click Install to complete the installation.
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Understand User Account Control Admin Approval Mode

If User Account Control: Run all administrators in Admin Approval Mode is enabled, run 
the installers by right-clicking the installer and selecting Run as Administrator. If this 
feature is disabled, you can run the installer normally. 

To verify the setting value (Enabled | Disabled):

1. Display the command window (Start > Command Prompt).

2. In the command window, type secpol.msc and press Enter.

3. In the Local Security Policy window, select Local Policies > Security Options. In the 
Policy column, find User Account Control: Run all administrators in Admin Approval 
Mode and view the Security Setting.

Power Options Settings

All Vantage servers should be set to High Performance in the Power Options Control 
Panel. This ensures that the network interface cards never sleep, which is desirable to 
ensure all Vantage servers remain in communication with each other all the time.

1. In Windows, display the Control Panel folder.

2. Search for Power Options. 

3. Click Power Options, and select High Performance.

4. Close the Control Panel.
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Third-Party Software Requirements
The following topics describe Vantage software requirements and recommendations 
for third-party products:

■ QuickTime Requirements

■ .NET Framework Requirements

■ Anti-Virus Software Recommendations

CAUTION: If you do not install/upgrade all required software, Vantage may not 
operate correctly.

QuickTime Requirements
The Telestream Media Transcode and Analysis engine requires QuickTime version 7.6.9 
if you plan to transcode QuickTime files. Obtain the free QuickTime installer from 
Apple.com at this URL: 

http://appldnld.apple.com/QuickTime/041-0025.20101207.Ptrqt/
QuickTimeInstaller.exe. 

Note: The Vantage Setup installer checks for QuickTime, and if QuickTime is not 
present, the installer installs QuickTime 7.6.9 for you if you have an Internet 
connection. If there is no Internet connection or QuickTime is present but outdated, 
the installer displays a message advising you to install QuickTime manually. Please use 
the URL above to download the correct version. If QuickTime is installed and up-to-
date, the installer leaves QuickTime untouched. 

After installation, be sure to uncheck (disable) Check for Updates, so that version 7.6.9 is 
not updated without your knowledge; then restart the server.

If you do not install the correct QuickTime version, encoding some formats causes this 
error: “An error occurred during execution of the Transcode Task: RenderSession 
Configuration Error, message: Requested encoder | decoder not installed.”

Note: Because QuickTime for Windows has security vulnerabilities as stated by the US 
Department of Homeland Security (DHS), you may prefer not to install it on your 
computers. If QuickTime is not installed, a number of Vantage functions will not 
operate, such as portal proxy playback and several Flip action functions. For details 
about the QuickTime vulnerability and the effect of removing it from Vantage systems, 
see the Telestream and QuickTime statement on the Telestream.net web site.

QuickTime 7.7.9 for Workflow Portal Client
The Workflow Portal desktop client preview player works best with QuickTime 7.7.9. 
This is the recommended version to use on Vantage client machines.

http://marketing.telestream.net/acton/fs/blocks/showLandingPage/a/5268/p/p-0116/t/page/fm/0
http://appldnld.apple.com/QuickTime/041-0025.20101207.Ptrqt/QuickTimeInstaller.exe
http://appldnld.apple.com/QuickTime/041-0025.20101207.Ptrqt/QuickTimeInstaller.exe
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.NET Framework Requirements
• Microsoft .NET Framework 4.8 is required on Vantage servers, client workstations, 

and Web Apps installations. This .NET version is installed automatically by the Van-
tage or Web Apps installer on all operating systems, if not already present.

• Microsoft .NET 3.5.1 is also required on Vantage servers that run the general purpose 
Flip action and on servers running SQL Server 2014, but it is not required on other serv-
ers or client machines. This .NET version must be installed manually using Server Man-
ager on servers that require it. After installation, open Server Manager > Roles > Server 
Roles, and check Web Server (IIS) to enable it. Then enable the services listed in the IIS 
Role Service Requirements table in the Installing Vantage chapter.  

Anti-Virus Software Recommendations
Telestream recommends that you do not use anti-virus software on Vantage servers. 
You should not enable real-time scanning. If you do use anti-virus software, you should 
identify Vantage as a safe or trusted application. Telestream recommends that you 
disable real-time file scanning, because it will impact performance and potentially lock 
files being processed, impacting Vantage’s ability to operate properly.

Note: Be sure to turn off anti-virus software during Vantage installation or install the 
anti-virus software after you install Vantage.

Network Requirements
These topics provide information on Vantage network requirements and guidelines:

■ IP Address and Subnet Recommendations

■ Port Requirements

■ Firewall Guidelines

■ Windows Authentication Guidelines

■ Time Synchronization Guidelines

IP Address and Subnet Recommendations
The following topics recommend best practices for configuring Vantage servers on 
your network. These are some principles governing Vantage operation on a network:

• Vantage Services communicate with each other (peer-to-peer) and require reliable 
communication to prevent services from being treated as offline or failed.

• Services require reliable communication with the database.

• UDP, which is used for database discovery and services, does not work across sub 
nets. This affects domain setup but not day-to-day operation.

• Desktop client software applications require access to the SQL database.
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Static IP Addresses Recommended
Telestream recommends using static IP addresses and/or a host file for all machines 
within a Vantage domain. This is especially important when the network does not have 
a DNS server. Static IP’s help ensure that there is an explicit machine name to host IP 
correlation, which has proven to be the most effective way to maintain a large cluster.

Single Subnet Recommended
In a Vantage array installation, Telestream recommends that you install the Vantage 
domain database, Vantage services, and client programs in the same subnet to avoid 
communication issues. Within Vantage client and web applications, the service 
discovery feature automatically discovers all Vantage domains within a subnet. If you 
must access a Vantage domain from outside the subnet that hosts the Vantage domain 
database, you can use a DNS host name or IP address to specify the domain.

Using Vantage Across Multiple Subnets
You can use Vantage across multiple subnets, provided you adhere to these 
requirements:

• The subnet must be reliable (not dropping significant numbers of packets); other-
wise there will be sporadic communication between services.

• DNS configurations must be set properly (for example, static host entries must be 
used if DHCP is used for dynamic IP addresses).

• Use host files to ensure that dynamic machine identities do not exist.

• Firewalls need to be disabled or have the appropriate ports open (see Firewall 
Guidelines later in this chapter).

• Check ALL subnets where services may be running to ensure that firewalls are con-
figured correctly.

• Client software running on a different subnet generally works without issues.

Considerations When Using Vantage on Multiple Subnets
Vantage software cannot discover services across subnets; when building the Vantage 
Domain you will need to add services manually:

Open the Vantage Management Console and add services to the domain as follows:

1. Select Services in the left column.

2. Click the Add Services icon in the right panel Services tool bar.

3. Select My Service/Machine is not listed.

4. Enter the machine name or IP address, and click OK.

5. Select the services you wish to add. 

Additionally, Vantage client software may not be able to discover the Vantage database 
across subnets. The first time you run the client software, do the following:
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1. Select My Domain is not Listed.

2. Provide the host name for the database, and click OK.

Troubleshooting Network Issues
The following list provides common network issues and solutions:

Symptom—Jobs are stalled in the waiting (yellow) state and are not being 
assigned to services:

• Problems: (1) Services go offline and online arbitrarily. (2) Services of that type are 
not available due to firewall restrictions.

• Solution: Review firewall settings.

• Problem: Services are not available at all.

• Solution: Review services and ensure that they are running.

Symptom—Services toggle in the Management Console, arbitrarily going 
offline and back on again. Service logs show “Unable to communicate with 
service”:

• Problem: May be a DHCP problem where IP addresses are changing.

• Solution: Ensure host tables are updated so that every service machine has a fixed 
name or use static IP addresses.

• Problem: May be an unreliable network causing other services to think that the ser-
vice has failed.

• Solution: Analyze packet loss on the network to locate points of unreliability 

• Problem: May be asymmetrical firewall configurations where machine A can com-
municate with B, but not vice versa.

• Solution: Review firewalls between services and ensure parity in terms of which 
ports are open.

Symptom—Services cannot be discovered in the Management Console, even 
when using explicit service names:

• Problem: Firewall configuration is likely blocking network traffic.

• Solution: Update firewall information to reflect requirements (see Firewall Guide-
lines later in this chapter).
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Port Requirements
Vantage services are pre-configured with the default TCP port numbers listed below. To 
enable network communications between Vantage components, ensure that there are 
no port number conflicts between the applications on each Vantage server. 

Note: For instructions on viewing or changing the default port settings, search for 
Configuring Vantage Services in the Vantage Domain Management Guide.

Vantage Services Ports

Vantage Service Ports
Analysis TCP: 8673, HTTP: 8672 
Aspera TCP: 8701, HTTP: 8700
AudioTools TCP: 8713 HTTP: 8712
Aurora TCP: 8689, HTTP: 8688
Avid TCP: 8739, HTTP: 8738
Baton TCP: 8703, HTTP: 8702
Catalog TCP: 8665, HTTP: 8664
Cerify TCP: 8727 HTTP: 8726
Cloud TCP: 8737 HTTP: 8736
Communicate TCP: 8663, HTTP: 8662
Edit TCP: 8699, HTTP: 8698
emotion TCP: 8733 HTTP: 8732
FileCatalyst TCP: 8715, HTTP: 8714
IPTV VOD TCP: 8697, HTTP: 8696
Live TCP: 8721 HTTP: 8720
MediaMate TCP: 8685, HTTP: 8684
Metadata TCP: 8675, HTTP: 8674
Metric TCP: 8719, HTTP: 8718
Monitor TCP: 8659, HTTP: 8658
Multiscreen TCP: 8683, HTTP: 8682
Nexidia TCP: 8725, HTTP: 8724
Pulsar TCP: 8717, HTTP: 8716
SDK TCP: 8677, HTTP: 8676
Signiant TCP: 8709, HTTP: 8708
Staging TCP: 8687, HTTP: 8686
TimedText TCP: 8735 HTTP: 8734
Traffic TCP: 8681, HTTP: 8680
Transcode TCP: 8671, HTTP: 8670
Transport TCP: 8661, HTTP: 8660
VidChecker TCP: 8705, HTTP: 8704
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Vantage Thick Client Ports
To enable network communication with Vantage Thick Clients, open the following ports.
 

Firewall Guidelines
Telestream recommends that you disable the Windows Firewall on all computers that will 
communicate with or support Vantage services. The default Windows Firewall 
configuration will block access to the Vantage server from other Vantage components, 
such as other Vantage machines running Vantage client software. If you do run a firewall, 
the following ports must be open to allow Vantage to communicate.

Note: Third-party port numbers are provided for convenience, but are beyond 
Telestream’s control and subject to change. The list is incomplete because of the many 
server products available. Contact product vendors for port usage details.

Vantage Clients or Third Party Software Ports to Open
Vantage Windows (Thick Clients) - Workflow Portal, Dublist Portal TCP: 54980
Vantage Clients SQL database access TCP: 1433, 49150-49300
Vantage Dublist Portal (Thick Client) pre-qualification support TCP: 8681 
SQL Browser service UDP: 1434 
TCP/IP network access (Microsoft Windows share/storage) TCP: 445 

Third Party Software Ports
Avid Interplay (Unity Client, 
Transfer Engine, Web Services)

Discovery: UDP port 8321. For other ports, see Avid 
documentation, Interplay Admin Guide, Interplay 
Software Installation and Configuration Guide

FTP (Passive mode) TCP: 20, 21. Custom FTP port numbers can be entered 
in Vantage workflows. Also, FTP uses additional port 
numbers as specified in the protocol specifications. 
Refer to the protocol specifications for additional 
information.

Grass Valley AMP Port 3811 by default.
Harris NEXIO TCP: 2098
HTTP TCP: 80
Microsoft Distributed Transaction 
Coordinator (DTC)

User configurable; default port: 3372 when TIP is 
enabled. See Microsoft documentation for details.

Server Message Block (SMB) TCP: 137–139, 445, UDP: 137–139, 445
SFTP TCP: 22 Custom SFTP port numbers can be entered in 

Vantage workflows. Also, SFTP uses additional port 
numbers as specified in the protocol specifications. 

SMTP TCP: 25. This default value is configured on Vantage 
servers as described in Configuring Vantage Email 
Notifications in the Vantage Domain Management Guide.

WS-Discovery TCP: 46123, UDP: 3702
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Windows Authentication Guidelines
By default, Vantage services use the Windows Local System account when accessing file 
space for media storage and delivery. When all Vantage services, clients, and delivery 
targets are on one server, the default configuration works well. When any Vantage 
service, client, or delivery target is on another computer, Windows authentication 
requirements must be met to enable communication between multiple computers.

The following topics provide additional authentication guidelines:

■ About Vantage Windows Authentication

■ Configuration Guidelines for the Vantage Windows User Account

■ Configuring Folders for Vantage Access

About Vantage Windows Authentication
A Vantage domain requires authentication planning when workflows require Vantage 
to ingest media from or send media to another computer. For remote file access, use 
the following guidelines:

• Configure each Vantage service that accesses files on another server to use a Win-
dows log in ID and password. For example: VantageWinUser.

• Configure each remote storage folder to support access from the log in ID for Van-
tage services.

• If the same service operates on multiple Vantage servers, and requires access to 
files at a remote location, configure the same log in ID and password for all 
instances of that service. 

For example, if the Transcode service is running on three servers, it operates as one 
Transcode service with three instances or nodes. Vantage requires that every Van-
tage node within a service use the same log in ID. 

Note: When a service is comprised of multiple nodes, the Local System account, 
which is the default log in ID for all-in-one installations, cannot be used because it 
represents a different user on each system.
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Configuration Guidelines for the Vantage Windows User 
Account
To support Vantage service access to other Vantage servers and file folders on other 
computers, Telestream recommends that you create a Vantage user account within the 
Windows domain or workgroup. To distinguish the Vantage Windows user account 
from regular Vantage user accounts, use a name that indicates that this is a Windows 
user account. For example, VantageWinUser. 

Your Windows domain or workgroup administrator can configure the Vantage 
Windows user account before Vantage installation. When configuring this account, 
consider the following guidelines:

• The Vantage Windows user account should be added to the local administrator 
group on each server so that Vantage has the proper authority to run Vantage ser-
vices and install Vantage software.

• The Vantage Windows user account must be authorized to log in as a service (see 
your Windows domain or workgroup administrator), so that Vantage services can 
log in as the Vantage Windows user on each Vantage server.

• The Vantage Windows user account should have appropriate read and write per-
mission to network locations that Vantage will access. These network locations 
include the Vantage store and input and output storage locations.

• You can use the Vantage Windows user account to install the Vantage software.

For instructions on configuring services to use the Vantage Windows user account, see 
Setting the Vantage Windows Log On ID for Services.

Configuring Folders for Vantage Access
Vantage servers and clients may need access to folders on other computers for any of 
the following:

• Input of files in Watch folders

• Manual submission of input files

• Storage of output files for future Vantage use

• Delivery of output files to remote destination folders

The following topics describe how to configure folders for Vantage use:

■ Configuring Folder Access Within the Windows Domain or Workgroup

■ Configuring Folder Access Outside of the Windows Domain or Workgroup

■ Configuring Access to a SAN System

Note: Vantage cannot access network locations defined using a Windows mapped 
drive. You must use a universal naming convention (UNC) path to define network 
locations for Vantage use.
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Configuring Folder Access Within the Windows Domain or Workgroup

If you create a Vantage Windows user account as described in Configuration Guidelines 
for the Vantage Windows User Account, granting Vantage access to any folder within the 
domain is as simple as granting access to the Vantage Windows user. If Vantage 
workflow designers, operators, or administrators also need access, grant folder access 
to their Windows user names.

Configuring Folder Access Outside of the Windows Domain or Workgroup

When Vantage needs to access computers in a different Windows domain or 
workgroup, the Windows log in ID from the current domain or workgroup is not 
accepted. To support Vantage service access, you can configure a Vantage 
authorization record as described in Specifying Authorization Credentials for Remote 
Folder Access in the Vantage Domain Management Guide.

Configuring Access to a SAN System

When you want to access files in a SAN system, be aware that some systems expose the 
shared drive as a letter (mapped) drive (for example, X:) that is visible on any client of 
the SAN. Although Vantage cannot reference a Windows mapped drive, you can 
reference SAN drives via a drive letter, provided that each Vantage server is a client of 
the SAN and that all mount points use the same letter.

Time Synchronization Guidelines
When a Vantage domain includes multiple servers and workstations, you should verify 
that all the computers are set to the same regional settings and the correct time zone. 
Otherwise, the timestamps associated with Vantage events may display incorrectly and 
time-driven events might not occur on schedule. When checking the time 
configuration in the Vantage domain, be sure to check the configuration on the 
following:

• All servers with Vantage services

• All Vantage domain database servers

• All Vantage web hosts

• All file servers that support Vantage stores and folders

• All workstations that run Vantage Workflow Designer, Vantage Workflow Portal, and 
Vantage Management Console (VMC)

Network time protocols on your network should keep the time within tolerances, as 
long as you correctly configure the following:

• The time zone for each server or workstation should be correct for the respective 
time zone.

• Any adjustment for daylight savings time should be consistent on all servers and 
workstations within the same time zone.
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Database Selection and Configuration Guidelines
The Vantage database has very specific requirements, and its configuration differs 
depending on your expected processing workload and whether you are installing 
Vantage in a Single-Node or Array configuration. For detailed database requirements, 
please see the following topics included in the Planning and Managing a Vantage 
Database chapter of this guide, in the Vantage Database Management Guide, or in the 
Vantage Domain Management Guide:

■ Operating System Requirements

■ Database Server Requirements for SQL Standard

■ Database Selection and Configuration Guidelines
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Vantage Installers Overview
The following topics introduce the Vantage installers:

■ Obtaining the Vantage Installer

■ Vantage Installation Package

Note: The Vantage installer on a USB memory stick is available upon request. Contact 
sales@telestream.net to request the installer on a memory stick.

Obtaining the Vantage Installer
The Vantage 8.1 installer is available from Telestream’s Web site. To locate and 
download the Vantage installer, follow these steps:

1. Use your Web browser to go to dynamic.telestream.net/downloads/download-
vantage.asp?prodid=vantage.

2. If you do not have a Telestream account, click Create an Account to display the 
Create a Telestream Account page. Fill out the form and click Create Account. You 
can use your user name and password immediately. Telestream will send you a 
confirmation email.

3. On the login page, enter your authorized user name & password, then click Log In.
4. On the Downloads page, click Download Now to download the Vantage 8.1 zip 

package.
Select a folder (or desktop) destination and click Save to download and save the 
Vantage 8.1 zip package on your computer. 

5. The Download Progress window displays as the file is downloaded to your 
computer. When the download is complete, close the Web browser.

6. Right-click the Vantage 8.1 zip package and select Extract All. Follow the steps to 
extract the files.

7. Among those files is the Vantage 8.1 installer zip file. Right-click this file to extract 
the Vantage_8.1_Setup.exe and other related files (such as ComponentPacs and 
utilities). After extraction, double click on the Vantage_8.1_Setup.exe installer to 
begin installation.

Other installers may be provided to allow installing of individual components and 
patches. 

Note: Installer files may include a build number in the file name, as indicated by the 
x’s in this example: Vantage_8.1_Setup_xx.xx.xxx.xxxxx.exe. These numbers are 
excluded in this guide for the sake of simplicity and clarity.

Later, in the Installation chapter, you’ll use these installers to install Vantage as directed.

http://dynamic.telestream.net/downloads/download-vantage.asp?prodid=vantage
http://dynamic.telestream.net/downloads/download-vantage.asp?prodid=vantage
mailto:support@telestream.net
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Vantage Installation Package
The installation package includes the following installers:

■ Vantage Setup Installer

■ Vantage Database Deployment Utility

■ Vantage Client Installer

■ Vantage Web Applications Installer

Vantage Setup Installer
The Vantage_8.1_Setup.exe installer is the main Vantage installation program. It installs 
all of the server software and all of the clients. When you use it to install Vantage 
programs and services, you can choose an all-in-one Single Node installation or an 
Array Node installation. Choose Single Node to install all components on a single 
server. Choose Array Node if you are installing selected components on a Vantage array 
server. You can also choose Install Products or Custom Install. Install Products lets you 
select licensed product groups, and Custom Install lets you select individual 
components. 

The Vantage Setup installer is capable of installing everything needed for a complete 
Vantage installation. If you check all components, Vantage Setup installs these items: 

• Creates a Telestream directory for Vantage and related files. For Single Nodes only, 
this directory includes Local Store, Default Catalog, and Samples workflow folders.

• Installs Intel Performance Primitives software for Intel processors

• Checks for QuickTime (used only by the Telestream Media Transcode and Analysis 
engine) and installs it if missing or advises if it is obsolete. 

• Installs SQL Server 2019 Express IF Express or Standard are not already installed. If 
the installer detects an existing SQL Server installation, it skips installing Express. 

• Creates a SQL instance named VANTAGE (only for automatic Express installations) 

• Creates the Vantage domain database on the VANTAGE instance

• Installs the Telestream Media Transcode and Analysis engine

• Installs Vantage services and client programs according to your selections, includ-
ing Web Applications for arrays

• Creates Control Panel Programs and Features entries for Telestream Media 
Transcoding and Analysis and Vantage 8.1. Other Vantage installers may add list 
entries, such as Vantage Clients or Vantage Web Applications.

• Creates desktop shortcuts for Vantage client applications on the desktop
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Vantage Database Deployment Utility
The Vantage Database Deployment Utility enables you to install or upgrade the 
Vantage domain database into an existing SQL installation, such as when installing the 
database as part of a Vantage Array database server installation. You must first install 
SQL. Then when you run the utility, it performs the following tasks:

• Creates a SQL instance named VANTAGE in the existing SQL installation

• Creates the Vantage domain database on the VANTAGE instance.

Note: If you run the database utility and a SQL instance named VANTAGE already 
exists, this utility will update the existing instance (while retaining all your data).

Vantage Client Installer
The Vantage Client installer (Vantage 8.1 Client Applications.msi) provides a convenient 
installer for quickly installing Vantage client applications on client workstations. The 
Client installer can install the Management Console, Workflow Designer, Workflow 
Portal, and Dublist Portal. 

Vantage Web Applications Installer
The Vantage Web Applications installer installs these Vantage Web Applications:

• Vantage Dashboard—allows administrators to view Vantage system information.

• Vantage Job Status Views—enables operators to view job status information, and if 
properly authorized, execute job controls.

• Vantage Workflow Portal (VWP)—allows operators to perform operator-intervention 
media processing tasks via an Internet connection.

• Vantage Dublist Portal—allows managing and processing of dublists for the Traffic-
Manager option. 

• Lightspeed Live Capture web application—manages live video capture as part of the 
Lightspeed Live Capture option.

• Vantage Tape Capture web application—manages the Lightspeed Tape Capture 
option to capture media from videotape.

• External Links—Provides access to a convenient “bookmarks page” for storing fre-
quently used Internet links.
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Licensing Overview
The following topics describe Vantage licensing: 

■ Using Vantage in Demo Mode

■ Obtaining a Vantage License

■ Adding or Replacing License Files

Note: A Vantage domain with more than one node requires one Vantage Array 
license per node. 

Using Vantage in Demo Mode
When you install Vantage without a license, Vantage operates in demo mode. Demo 
mode allows you to design workflows, input Windows Media (WMV and AVI) files for 
transcoding (with a watermark), and analyze a few seconds of video and audio. Some 
features that are not available in demo mode include:

• Support for monitoring and delivering to broadcast servers

• Support for conversion of XML files and third party integrations

Note: If you'd like to unlock the entire set of features in Vantage for a time-limited 
trial, please contact your Telestream sales representative, or contact the Telestream 
sales team at sales@telestream.net. Demonstration mode is limited to all-in-one single 
node domains.

mailto:support@telestream.net
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Obtaining a Vantage License
You must obtain, install, and activate a license to:

• Test a Vantage array in demo mode

• Operate Vantage in production

• Upgrade Vantage from one version to another

• Add more Vantage services (more Transcode services, for example)

• Add licensed features (the Advanced Avid option, for example).

Please contact your Telestream sales representative or contact the Telestream sales 
team at sales@telestream.net to determine your Vantage requirements and obtain or 
update your license. When your license has been prepared, Telestream will email you 
the license as an attachment.

For Telestream contact details, go to www.telestream.net/company/contact-
telestream.htm.

When you receive the license (an XML file), save it in a safe place for installation and 
activation at the end of the installation process.

Adding or Replacing License Files
Depending on your requirements, you may obtain a new license file or you may obtain 
updated files. Contact Telestream Sales or Customer Service, and follow their 
instructions for adding or updating license files.

Note: You can evaluate an All-in-One Single Node Vantage installation without 
installing a license. Demo mode allows you to design workflows, perform transcoding 
with a watermark, and analyze short video or audio clips. However, in demo mode (no 
license is installed), some features (such as broadcast server protocols) are disabled, 
and Vantage can only read Windows Media (WMV and AVI) files for transcoding or 
analysis. You cannot operate a Vantage array without a license.

mailto:support@telestream.net
http://www.telestream.net/company/contact-telestream.htm
http://www.telestream.net/company/contact-telestream.htm
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Planning for a Vantage Array Installation
Prior to installing a Vantage array, Telestream recommends that you develop a system 
diagram, indicating each server and the Vantage services and client programs it should 
host, plus the database server (and optional mirror and witness server).

The diagram should also identify which computers host client programs (Vantage 
Management Console, Vantage Workflow Designer, and Vantage Workflow Portal).

Additionally, document all network resources utilized by the Vantage domain (file 
sources and destinations).

When adding Vantage services to scale performance, Telestream generally 
recommends adding one or more Vantage transcoding servers, which is typically the 
first service to max out server capacity. Multiple transcode servers improves load 
balancing and speeds overall job throughput. Secondly, if you use the Vantage Analysis 
service heavily, consider hosting it on a dedicated server as well.

Note: Each server hosting Vantage services requires a Vantage Array or Vantage 
Enterprise System Management license. Dedicated database servers do not require a 
special license.

Note: When naming servers, do not use underscores in the names. Underscores are 
not valid URL characters and will prevent the Web Applications from connecting to 
the Vantage domain.

Gig-E Ethernet Fibre-Channel Local Storage

Network Servers

FTP Servers

Catch Servers

Broadcast Servers

Principle Database & IIS Server

Mirror Database Server

Witness Server

Automatic Failover

Vantage Analysis server

Vantage Transcode server 1

Vantage Transcode server 2

Lightspeed Server 1

Lightspeed Server 2

Vantage Workstations
    Vantage Domain Console
    Vantage Workflow Designer
    Vantage Workflow Portal
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Planning and Managing a 
Vantage Database

This guide lists Vantage database requirements and explains how to install and manage 
the Vantage Database.

Installing a database in preparation for Vantage is easiest when you plan carefully, and 
you have a working knowledge of Windows server administration, Microsoft SQL 
Server, and installation and configuration of enterprise-level software. Consult your IT 
group for assistance as necessary.

Note: Go to www.telestream.net/telestream-support/vantage/support.htm to 
browse the Vantage Web library, user guides, patches, application notes, and other 
documents.

The following topics provide information for planning, installing, and maintaining a 
Vantage database:

■ Operating System Requirements

■ Database Server Requirements for SQL Standard

■ Database Selection and Configuration Guidelines

■ Installing MS SQL Server

■ Installing the Vantage Database

■ Backing Up and Restoring the Vantage Database

■ Shrinking a Full Database

■ Moving the Vantage Domain Database to Another Database

http://www.telestream.net/telestream-support/vantage/support.htm
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Operating System Requirements
The Vantage Domain Database and the MS SQL Server for Vantage should be installed 
and operated only on the following operating systems (64-bit only):

• Windows Server 2012 R2

• Windows Server 2016 Standard or Data Center Edition

• Windows Server 2019 Standard or Data Center Edition

Note: Operating System support presented here is current at the time of publication. 
However, updates to supported Operating Systems may occur. Verify that the server 
on which you plan to install Vantage meets the platform requirements, as specified at 
telestream.net/vantage/tech-specs.htm. 

Database Server Requirements for SQL Standard
The following recommendations are for customers running SQL Standard. To 
determine which version of SQL to use, please refer to the Guidelines for Selecting SQL 
Express or SQL Standard.

Telestream recommends using “per core” SQL Standard licensing when using Vantage. 
In this licensing scenario, all physical cores on the server (or virtual machine) must be 
licensed. Please contact your IT department or Microsoft for more information about 
SQL Standard licensing options. For Microsoft’s discussion of licensing by cores, refer to 
this URL: http://www.microsoft.com/licensing/about-licensing/briefs/licensing-by-
cores.aspx.

Telestream recommends the following hardware for dedicated database servers:

SQL Standard: 4-Core Server Minimum Recommendations

Component Specification

CPU 64-bit, 4 physical cores, 8 MB cache, 3.0 GHz or greater. For 
example, Intel E3-1230 v2.

RAM 16 GB DDR minimum required, 32 GB or more recommended 
for high job volumes; 1600 MHz recommended

OS/Software HDD RAID-1, 2 drive volume, minimum 7200 RPM, SSD preferred

Database HDD RAID-5, 3 drive volume, minimum 250 GB per drive, 7200 RPM

Network Dual 1 GbE or greater NICs

Operating System Windows Server 2012 R2, 2016, or 2019

http://www.microsoft.com/licensing/about-licensing/briefs/licensing-by-cores.aspx
http://www.microsoft.com/licensing/about-licensing/briefs/licensing-by-cores.aspx
https://www.telestream.net/vantage/tech-specs.htm
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Please see the following page and table for additional guidelines.

When choosing your database server, the primary consideration is how many clients 
will access job status views simultaneously. Real-time job status views are the largest 
consumer of database CPU resources. 

The following table can guide you in selecting a server and configuring the system. 

Note: The recommendations above ensure sufficient CPU headroom for activities 
such as Workflow Portal operation, running large arrays, deleting jobs, etc.

For additional guidelines on database installation in a Vantage domain, see Database 
Selection and Configuration Guidelines.

SQL Standard: 8-Core Server Minimum Recommendations

Component Specification

CPU 64-bit, 8 physical core processors, 2.0 GHz or greater. For 
example, Intel ES-2640 v2.

RAM 24 GB DDR minimum required, 32 GB or more recommended 
for high job volumes; 1600 MHz recommended

OS/Software HDD RAID-1, 2 drive volume, minimum 7200 RPM, SSD preferred

Database HDD RAID-5, 3 drive volume, minimum 250 GB per drive, 7200 
RPM

Network Dual 1 GbE or greater NICs

Operating System Windows Server 2012 R2, 2016, or 2019

Job Status View Clients Database Server Notes

1 or 2 clients 4-core server IIS and the Workflow Designer 
may run on the DB server.

3-8 clients 4-core server IIS and Workflow Designer must 
run on a separate server.

More than 8 clients 8-core server (or more) Contact Telestream for guidance 
if you plan to have more than 20 
clients.
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Database Selection and Configuration Guidelines
If no other Microsoft SQL database version is already installed, Vantage automatically 
installs Microsoft SQL 2019 Express. If a Microsoft SQL database is already installed, 
Vantage detects it and does not install the default Express version.

Vantage is supported on the following database systems: 

• Microsoft SQL Server 2012 Express, Standard, or Enterprise

• Microsoft SQL  Server 2014 Express, Standard, or Enterprise

• Microsoft SQL Server 2016 Express, Standard, or Enterprise

• Microsoft SQL Server 2019 Express, Standard, or Enterprise

The MS SQL Server for Vantage should be installed and operated only on the following 
operating systems (64-bit recommended for performance):

• Windows Server 2012 R2

• Windows Server 2016 Standard or Data Center Edition

• Windows Server 2019 Standard or Data Center Edition

The following topics provide guidelines for choosing and implementing a database:

■ Guidelines for Selecting SQL Express or SQL Standard
■ Guidelines for an Array Installation with SQL Standard
■ Other Database Configurations
■ Improving Uptime with Mirroring or Availability Groups
■ Installing the Vantage Database

Note: SQL database tools must not be used to move a Vantage domain database of 
one version to a later version of Vantage. To upgrade Vantage, only use Vantage 
installers or the Vantage Database Deployment Utility.
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Guidelines for Selecting SQL Express or SQL Standard
The decision about whether to use SQL Standard or Express depends on your planned 
maximum database size and the expected average volume of database traffic. The 
following topics provide information to help you choose which database to use:

■ Comparing SQL Express and SQL Standard

■ Vantage Guidelines for SQL 2019 Express

Comparing SQL Express and SQL Standard
SQL Express and SQL Standard database limitations are compared in this table: 

Microsoft offers additional information about SQL Server capabilities and limitations at 
this URL: http://msdn.microsoft.com/en-us/library/cc645993.

Vantage ships with SQL 2019 Express, which is suitable for single-node installations or Array 
installations up to four nodes. For very large installations, SQL Standard may be required.

Vantage Guidelines for SQL 2019 Express
Vantage installs SQL 2019 Express, which allows up to 10GB of database storage. Due to 
this storage limitation, SQL Express is not suitable for every Vantage installation.

The following guidelines indicate the maximums for using Vantage with SQL 2019 Express:

• Transcoding:SQL 2019 Express can support up to 15,000 Vantage jobs in the data-
base at a time. Note: This assumes that each job contains 10 actions. More actions in a 
job require more storage, allowing fewer jobs.

• TrafficManager: SQL 2019 Express can support up to 1,500 TrafficManager com-
mercials in inventory at a time.

• Vantage Array: Up to four (4) Vantage servers can simultaneously connect to SQL 
2019 Express as part of a Vantage Array. This includes any redundant or backup 
machines.

Database Shutoff Feature for SQL Express
If a Vantage single-node or Array installation using SQL Express nears the SQL Express 
database size limit, Vantage stops accepting jobs. Attempts to submit jobs manually 
launches a warning dialog indicating that the database is at or near capacity. To release 
space in the database, see the procedure in the Managing a Vantage Domain chapter: 
Shrinking a Full Database in the Vantage Domain Management Guide.

SQL 2014/2016/2019 Express SQL 2014/2016/2019 Standard

Max. Cores: 4 Max. Cores: 16/24/24

Max. DB RAM: 1 GB Max. DB RAM: 64/128 /128 GB

Database Size: 10 GB Max. Database Size: 524 PB

http://msdn.microsoft.com/en-us/library/cc645993
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Guidelines for an Array Installation with SQL Standard
For high traffic installations, Vantage performance improves when you use SQL 
Standard and separate the database from other services such as the operating system 
and Vantage services. The following guidelines provide increasing levels of 
performance improvement:

• Always place SQL Standard and the database on a dedicated server, separate from 
Vantage services, the Vantage store, and the input and output files. This approach 
provides the largest increase in performance. 

• Place the Vantage database files on a dedicated physical drive or RAID array, sepa-
rate from the operating system.

Note: Installing a Vantage domain database on a separate server does not require an 
extra Vantage license for that server.

When installing a Vantage array with SQL Standard, ensure that the server hardware 
meets the requirements described in Operating System Requirements. To improve 
database availability, see Improving Uptime with Mirroring or Availability Groups. 

Recommendations for Large Arrays
For arrays containing 10 or more nodes, consider these additional recommendations: .

Other Database Configurations
Vantage systems can work with other special database configurations:

• For a fully redundant system, you can use SQL Standard with Mirroring. This 
requires professional services from Telestream with machines and licenses for two 
SQL Standard databases, plus a third machine running the free SQL Express. 

• Large volume systems can use SQL Enterprise. 

• You can use SQL with Clustering. 

Feature Recommendation

Server memory for DB < 32 GB 64 GB 

Server memory for DB > 32 GB 128 GB

Cores 16 cores minimum, 24 cores recommended.

Partitioning Create a dedicated partition for SQL Server data.

SSD or hard drives SSDs may provide better performance but only in 
cases of high I/O. Use SQL to monitor I/O wait times 
and PERFMON to measure average disk I/O latency. 
Latency should be less than 0.020 seconds (20 ms).
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Improving Uptime with Mirroring or Availability Groups
SQL Server Availability Groups or database mirroring can prevent Vantage domain 
interruption if a single database server fails. Telestream supports mirroring for SQL 
Standard 2012 and SQL Standard 2014 and Basic Availability Groups for SQL Standard 
2016 and SQL Standard 2019. SQL Enterprise with Clustering may also be used for high 
availability.

A mirrored database requires the following physical servers:

• A dedicated server to host the principal database

• A dedicated server (of similar capability to the principal database server) to host the 
mirror database

• An optional dedicated server to host the witness server. 

The witness database is a lightweight service which can run effectively on a low-end 
server, but cannot be installed on a database server.

Basic Availability Groups require:

• A dedicated server to host the primary replica database

• A dedicated server (of similar capacity) to host the secondary replica database

• A reliable witness file share server.

Note: This guide does not provide instructions for installing or implementing a 
mirrored database or Availability Groups. Consult your database administrator or 
contact your Telestream representative regarding installation service options.

Note: Telestream strongly recommends using a dedicated server for the witness 
server to ensure uninterrupted operation in case of a database failover. If the witness 
server function is placed on a server with Vantage services, transcoding can consume 
too many resources and prevent timely database switchover.

Note: If a mirrored database fails over, the domain change is not reflected in Vantage 
client program title bars, which still show the original domain name. Users can correct 
this by using File > Change Vantage Domain in the clients to select the new domain.
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Installing MS SQL Server
If you are creating or upgrading a Single-Node Vantage installation, pre-installing the 
database is not necessary. The Vantage Setup installer will install MS SQL Server Express 
and the Vantage database automatically on the single-node server with the Vantage 
applications and services. 

However, if you are installing or upgrading an existing Vantage Array installation on 
multiple servers, you need to have MS SQL Server Standard (or better) installed before 
you install the Vantage product using the Vantage Setup installer. This procedure will 
guide you through the MS SQL Server Standard installation, and the procedure that 
follows (Installing the Vantage Database) will install or upgrade the Vantage database. 
After SQL Server and the Vantage database are installed, you can install the Vantage 
Array using the Vantage Setup installer.

This guide does not provide instructions for installing a mirrored database and 
implementing mirroring. Consult your database administrator or contact your 
Telestream representative regarding installation service options.To set up the Vantage 
domain database, follow these procedures in the order listed:

■ Installing SQL Server 2012 Standard

■ Installing SQL Server 2014 Standard

■ Installing SQL Server 2016/2019 Standard

■ Installing the Vantage Database

Installing SQL Server 2012 Standard
The following procedure explains how to install SQL Server 2012 Standard. If you are 
installing SQL Server 2014 or SQL Server 2016, please skip to that topic, Installing SQL 
Server 2014 Standard or Installing SQL Server 2016/2019 Standard.

Follow these steps to install SQL Server 2012 Standard on a server:

1. Log into the target server with a local administrator account.

2. Insert the SQL Server 2012 Standard DVD into the server’s DVD drive and start the 
installer (setup.exe) if it does not run automatically.

3. SQL Server Installation Center—Click Installation in the left column, then select 
New installation or add features to an existing installation.

4. Setup Support Rules—Click OK.

5. Product Key—Enter your product key and click Next.

6. License Terms—Accept the license terms and click Next.

7. SQL Server Updates—Click Next after updates have completed. 

8. Feature Selection—Check Database Engine Services and Management Tools, and 
click Next.



Planning and Managing a Vantage Database
Installing MS SQL Server

49

9. Instance Configuration:

a. Select Named instance.
b. Enter VANTAGE in the Named instance field and the Instance ID field.
c. Click Next to continue.

10. Disk Space Requirements—Click Next to continue.

11. Server Configuration:

a. For SQL Server Agent, the Startup Type should be disabled. (If the Startup Type is 
set to automatic, the service must be stopped before running Vantage Setup.)

b. For Server Database Engine, select NT AUTHORITY\NETWORK SERVICE
c. Click Next to continue.

12. Database Engine Configuration:

a. Click Add Current User.
b. Select Mixed Mode.
c. Enter the Vantage sa user password (vantage12!) in the Enter Password and 

Confirm Password fields.
d. Click Next to continue.

13. Continue to click through the installer windows accepting the default settings to 
complete installation.

14. Complete—Click Close to close the SQL Server installer.

15. Select Start > SQL Server Management Studio.

16. Connect to the Vantage domain database using the following information:

Server type: Database Engine
Server name: [hostname]\VANTAGE
Authentication: SQL Server Authentication
Login: sa
Password: vantage12!

17. In the Object Explorer panel, right-click [hostname]\VANTAGE and select Properties.

18. In the Server Properties window, go to the Memory page.

19. Set the Maximum server memory (in MB) to 75% of the system's memory. For 
example: If the system's memory is 8 GB (8192 MB), then the maximum server 
memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).

20. Click OK.

21. Close the SQL Server Management Studio.

Now that SQL Server Standard is installed and configured for Vantage, install the 
Vantage domain database as explained in this topic: Installing the Vantage Domain 
Database. The Vantage installer will detect that SQL Standard is already installed, will 
not install SQL Express, and will attach to the installed instance.
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Installing SQL Server 2014 Standard
Follow these steps to install SQL Server 2014 Standard on a server (skip this topic if you 
already installed another version of SQL Server):

1. Launch setup from the SQL Server 2014 Standard installation media.

2. In the SQL Server Installation Center, go to Installation on the left.

3. Select New SQL Server Stand-alone installation or add features to an existing 
installation.

4. On the Product Key page, enter a product key and click Next.

5. Accept the license terms and click Next.

6. Click Next on the Microsoft Update page.

7. On the Setup Role page, select SQL Server Feature Installation and click Next.

8. On the Feature Selection page, enable Database Engine Services, Management Tools 
– Complete and click Next.

9. On the Instance Configuration page, select Named instance, enter VANTAGE and 
click Next.

10. On the Server Configuration page, click the cell for the account name of the SQL 
Server Database Engine service. After selecting the cell, click the drop-down list and 
select <<Browse…>>.

11. In the Enter the object name to select field, type NETWORK SERVICE and click OK. 
Then click Next on the Server Configuration page.

12. On the Database Engine Configuration page, select Mixed Mode (SQL Server 
authentication and Windows authentication). Enter vantage12! for the password and 
click the Add Current User button. 

13. (Optional) If you would like to specify a non-default location for the database files, 
go to the Database Engine Configuration page, select the Database Directories tab, 
and change the Data root directory path.

14. Click Next on the Database Engine Configuration page.

15. Click install on the Ready to Install page.

16. When installation completes, click Close and close the SQL Server Installation 
window.

17. From the Start menu, launch the SQL Server 2014 Management Studio.

18. In the Server name field, enter .\vantage as the server name.

19. Set authentication to SQL Server Authentication.

20. Enter sa for the login and vantage12! for the password.

21. In the Object Explorer panel, right click .\vantage (SQL Server 12.0.2000 – sa) and 
select Properties.

22. From the Select a page panel, go to Memory and set Maximum server memory (in 
MB) to 75% of the host system’s memory. For example, if the system's memory is 8 
GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB 
(6144 MB) (8192 x 0.75 = 6144).
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23. Click OK to close the Microsoft SQL Server Management Studio window.

Now that SQL Server Standard is installed and configured for Vantage, install the 
Vantage domain database as explained in this topic: Installing the Vantage Domain 
Database. The Vantage installer will detect that SQL Standard is already installed, will 
not install SQL Express, and will attach to the installed instance.

Installing SQL Server 2016/2019 Standard
Follow these steps to install SQL Server 2016 SP1 Standard or SQL Server 2019 Standard 
on a server (skip this topic if you have already either of these versions installed):

1. Launch setup from the SQL Server 2016/2019 Standard installation media.

2. In the SQL Server Installation Center, select Installation on the left.

3. Select New SQL Server Stand-alone installation or add features to an existing 
installation.

4. On the Product Key page, enter a product key and click Next.

5. Accept the license terms and click Next.

6. Click Next on the Microsoft Update page and the Install Rules page.

7. On the Feature Selection page, click Feature Selection on the left, enable Database 
Engine Services and click Next. 

8. On the Instance Configuration page, select Named instance, enter VANTAGE and 
click Next.

9. Click the cell where the SQL Server Database Engine Row and Account Name 
column intersect. After selecting the cell, click the drop-down list and select 
<<Browse…>>. 

10. In the Enter the object name to select field, type NETWORK SERVICE and click OK. 
Then click Next on the Server Configuration page. 

11. On the Database Engine Configuration page, select Mixed Mode (SQL Server 
authentication and Windows authentication). Enter vantage12! for the password and 
click the Add Current User button. 

12. (Optional) If you would like to specify a non-default location for the database files, 
go to the Database Engine Configuration page, select the Data Directories tab, and 
change the Data root directory path.

13. Click Next on the Database Engine Configuration page.

14. Click Install on the Ready to Install page.

15. When installation completes, click Close and close the SQL Server Installation 
window.

16. (SQL Server 2016) Install SQL Server 2016 Service Pack 1 (SP1):

https://www.microsoft.com/en-us/download/details.aspx?id=54276

Installing SQL Server Management Studio

Management Studio is not automatically installed for SQL Server 2016/2019. To install 
and configure it, follow these steps:

https://www.microsoft.com/en-us/download/details.aspx?id=54276
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1. Browse to https://msdn.microsoft.com/en-us/library/mt238290.aspx.

2. Click the link to “Download SQL Server Management Studio.” At the time this 
document was written, version 18.9.2 is available.

3. After the download completes, launch the setup and click Install.

4. Click Close when the installation completes.

After the SQL Server Management Studio has been installed, it must be used to set the 
maximum limit for SQL Server's memory consumption:

1. From the Start menu, launch the SQL Server Management Studio.

2. Connect to the instance using SQL Server Authentication:

Server name: .\VANTAGE
Authentication: SQL Server Authentication
Login: sa
Password: vantage12!

3. Right-click the hostname at the top of the Object Explorer tree and select 
Properties.

4. From the Select a page panel, go to Memory and set Maximum server memory (in 
MB) to 75% of the host system’s memory. For example, if the system's memory is 8 
GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB 
(6144 MB) (8192 x 0.75 = 6144).

5. Click OK to close the Microsoft SQL Server Management Studio window.

Now that SQL Server Standard is installed and configured for Vantage, install the 
Vantage domain database as explained in this topic: Installing the Vantage Domain 
Database. The Vantage installer will detect that SQL Standard is already installed, will 
not install SQL Express, and will attach to the installed instance.

https://msdn.microsoft.com/en-us/library/mt238290.aspx
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Installing the Vantage Database 
If you have already installed MS SQL Server 2012, 2014, 2016, or 2019 the Vantage Installer 
allows you to install or upgrade a current Vantage database in the existing SQL installation. 
You can install in any of these MS SQL database versions:

• SQL Express

• SQL Standard, SQL Standard with Mirroring, SQL Standard with Clustering

• SQL Enterprise and SQL Enterprise with Clustering

Before you begin, follow the prerequisite procedure below.

Prerequisites for Instance Installation
It is assumed you have already created a SQL database instance into which a Vantage 
database instance can be deployed. The database instance must meet certain 
prerequisites before you can use the Vantage utility to deploy a Vantage database 
instance:

• The SQL instance must be deployed as a named instance.

• The SQL instance must include a SQL or active directory user account. The user can 
be sa or another account, and any password may be used.

The user account installing the Vantage database must have the sysadmin role 
assigned. The steps below explain how to assign a role.

• The user account running the Vantage database after it is installed can have the 
db_owner and dbcreator roles assigned instead of sysadmin, if you prefer the user to 
have lower privileges.
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Configuring the Administrator Role
1. In the SQL Server Management Studio > Object Explorer panel, expand Security, 

and expand Logins.

2. Right-click the sa user or another user that you want to use as the administrator 
login, and select Properties.

3. Go to Server Roles and enable public and sysadmin. Click OK. This gives the user 
system administrator privileges for the database instance.
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Configuring the Vantage User Role
1. Right-click the current Windows user and select Properties. 

2. Click User Mapping. Check master or Vantage (if present) in the database column, 
and check db_owner. Click OK. 

3. Right-click the Windows user and select Properties again.

4. Click Server Roles and check dbcreator to enable it. Click OK. This gives the current 
Windows user sufficient privileges to run the Vantage database instance after 
installation.
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5. From the Select a page panel, go to Memory and set Maximum server memory (in 
MB) to 75% of the host system’s memory. For example, if the system's memory is 8 
GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB 
(6144 MB) (8192 x 0.75 = 6144).

6. Click OK to close the Microsoft SQL Server Management Studio window.

Installing the Vantage Domain Database
This task installs a clean new Vantage domain database instance into the previously 
installed SQL database. Follow these steps:

1. Log into the database server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall is off.

Note: To effectively operate Vantage services with other networked devices or 
systems, you must turn off Windows Firewall.

2. Stop the SQL Server Agent Service in Start > Services, if it is running. 

3. Run the Vantage _8.1_Setup installer. See Vantage Installers Overview for details.

4. When the Welcome dialog appears, click Next to display the license agreement. 

5. License Agreement—Click I Accept if you agree to the license terms, and then click 
Next.

6. Select Array {Multi-Node} Installation and click Next.

7. Select the type of installation you want to perform: Install Product or Custom Install. 
Install Product lists products and options in licensed groups. Custom Install lists 
every Vantage component and option and allows you to select what you want. 
Click Next.

8. Browse to Configure the installation locations for the Installation base, the default 
Vantage Store. Defaults are recommended.

9. Enable Install Vantage Database to install the Vantage database.

10. When Ready to Install appears, click Install to begin installation, which takes a few 
minutes. Progress is displayed as the installation takes place.

Note: The Vantage Setup program checks for an existing SQL Server installation, and 
if found, Setup skips the installation of SQL Server. If SQL Server is not found, SQL 
Server 2019 Express will be installed. Similarly, if no Vantage database is found, a new 
one is installed. If a Vantage database is found, it is upgraded; upgrading preserves 
workflows, design items, job history, catalogs, stores, application configurations, user 
settings and licenses.

11. Click Next when the installer indicates it is finished. 

12. The installer displays Installation was successful! (or indicates errors if unsuccessful). 
Click Done to close the installer application. Database installation is complete.
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13. Launch the SQL Server Management Studio.

14. Connect to the instance using SQL Server Authentication:

Server name: .\VANTAGE
Authentication: SQL Server Authentication
Login: sa
Password: vantage12!

15. Right-click the hostname at the top of the Object Explorer tree and select 
Properties.

16. Go to Memory on the left and set “Maximum server memory (in MB)” to 75% of the 
server’s memory. Click OK.

17. You are now ready to install or upgrade Vantage:

Note: For detailed Vantage installation instructions, please refer to the Vantage 
Installation Guide, available as a standalone guide and also included in the Vantage 
Domain Management Guide.

a. New Vantage Installations: If you are installing a new Vantage instance, run the  
Vantage_8.1_Setup.exe installer again , select Array {Multi-Node} Installation, 
select Custom, select the components you want, but do NOT select Database. 
This ensures Vantage installs, but the database is not touched.

b. Upgrading Vantage: If you are upgrading an existing Vantage instance, use the 
Control Panel Programs and Features to remove only Vantage but leave MS SQL 
and the domain database in place. Then run the  Vantage_8.1_Setup.exe installer 
, select Array {Multi-Node} Installation, select Custom, select the components you 
want, but do NOT select Database. This ensures Vantage installs, but the 
upgraded database is not touched.
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18. After Vantage installation, use the Vantage Management Console > File > Change 
Vantage Domain (shown below) to find and connect your Vantage installation to 
the deployed database. Use the Search button to populate the list. 

If you installed a Vantage database with a custom name and password, you may 
need to select Specify Vantage Domain name/IP Address. Then enter the server 
name, the custom database name, expand the Connection settings, and enter the 
custom Login and Password. When you click OK, the Vantage Management Console 
should connect to the database and begin normal operation. 

REMINDER: If you use Windows authentication, you must also set the SQL Server 
service Log On to the same Windows account that you will use for database 
authentication. To change the SQL Server service Log On, select Start > Administra-
tive Tools > Services > SQL Server > Properties > Log On > This account. 

19. If necessary (for a new installation), install Vantage licenses using the Vantage 
Management Console > Licenses panel and configure Vantage as described in the 
Vantage Domain Management Guide. 

20. If you have deployed a new database or replaced an existing database with a new 
one, the domain will not have any ComponentPacs installed. When you run the 
Vantage Setup installer to install Vantage components and services after deploying 
the database, the major ComponentPacs will be installed. If you do not run the 
Vantage Setup installer after database deployment on the database server, or if you 
wish to install additional ComponentPacs, use the Vantage Management Console > 
ComponentPac Management feature to install the ComponentPacs.

21. Lastly, if you assigned the Vantage services to the host name of the database server 
before using the Database Deployment Utility, use the Microsoft Services Console 
to restart the Vantage services after the database is deployed. Also close and 
reopen the Vantage Management Console and Workflow Designer. These 
operations prevent a situation where Vantage action templates and fulfillment 
schemes do not deploy properly.
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Database Maintenance Topics
The topics covered in the remainder of this guide explain how to perform typical 
database maintenance procedures:

■ Backing Up and Restoring the Vantage Database

■ Shrinking a Full Database

■ Moving the Vantage Domain Database to Another Database
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Backing Up and Restoring the Vantage Database
The Domain Backup feature allows you to save archival copies of the Vantage domain 
database in a separate file. The Domain Restore feature allows you to replace your 
current Vantage domain database with the contents of a previously-backed up domain. 
The domain backup and restore features are primarily used for the following:

• Returning the database to a previously backed-up state.

• Preparation for database mirroring.

Note: The domain backup and restore features are not designed for use during 
Vantage upgrades. If you back up the database from a specific version of Vantage, that 
backup can only be restored to the same Vantage software version. During a Vantage 
upgrade, the Vantage installers manage any required database updates as described 
in Upgrading from a Previous Version in the Vantage Installation Guide or the Vantage 
Domain Management Guide.

The following topics describe domain backup and restore:

■ Understanding Domain Backup and Restore

■ Backing Up the Domain

■ Restoring the Domain

Understanding Domain Backup and Restore
During a domain backup, Vantage creates a single backup file that contains all 
workflows, all services, and all jobs registered in the domain. It is important to 
remember that the backup file contents reflect the domain contents as of the moment 
the backup file is created. To capture changes made after a backup, you must create 
another backup.

When you restore a domain, all services are stopped, the current database contents are 
irretrievably destroyed, and the backup file you specify is used to create the 
replacement database. The services defined in the backup file are started and the 
Vantage domain database repopulates with the backup database values.

Because the restore feature irretrievably destroys the contents of the current database, 
Telestream recommends that you back up the current database before restoring a 
previous database. Backing up the current database captures all database changes 
made since the last backup, and it gives you a backup file that you can use to restore 
the current database if necessary. 



Planning and Managing a Vantage Database
Backing Up and Restoring the Vantage Database

61

Backing Up the Domain
To back up the Vantage domain database, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console in the Vantage System Administration Guide or the Vantage 
Domain Management Guide.

2. In the components panel, select Domain Management.

Vantage displays the Domain Management details panel shown in this figure:

3. Verify that all services in the Active Services list are hosting 0 sessions.

Note: Although you can create a successful backup while services are executing 
workflow tasks, some job records may be lost. It is best to back up the domain when 
there is no activity in the domain.

4. Click the Backup... button.

5. In the Save the domain dialog, browse to the folder where you want to store the 
backup file, and click Save.

6. When the Backup Complete message appears, click OK.
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Restoring the Domain

CAUTION: Telestream recommends that you restore a Vantage domain using the 
same machine that created the backup file. If you restore the domain from another 
machine, the services defined in the database must match the services installed on 
the other machine.

To restore a Vantage domain database, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console in the Vantage System Administration Guide or the Vantage 
Domain Management Guide.

2. In the components panel, select Domain Management.

Vantage displays the Domain Management panel shown in the previous figure.

3. To provide the option to return to the current Vantage domain database later, back 
up the current domain database as described in Backing Up the Domain.

CAUTION: Always back up your current database before restoring it to an earlier 
backup. Restoring your Vantage domain database overwrites the entire contents of 
the current database with the contents of the backup file selected.

4. Verify that all services in the Active Services list are hosting 0 sessions.

Note: When you restore a domain, all services are stopped, and all information 
related to any jobs in progress is lost. The restored database contains only the domain 
information captured when the domain was backed up.

5. Click the Restore... button, read the information dialog that appears, and click OK.

6. In the Load the domain dialog, browse to the backup file you want to restore, select 
the backup file, and click Open.

7. When the Restore Complete message appears, click OK.
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Shrinking a Full Database
If a Vantage installation using SQL Express nears the SQL Express database size limit, Vantage 
stops accepting jobs. Attempts to submit jobs manually launches a warning dialog indicating 
that the database is at or near capacity. 

You may be able to resolve this issue using the Vantage Shrink Database feature, which 
applies the MS SQL DBCC SHRINKDATABASE command to the existing database to delete 
unused entries and reduce file size. The shrink process may take some time and may slow 
database performance, so it should be done only when the Vantage system is not busy.

Use this procedure to shrink the database:

1. Start the Vantage Management Console.

2. In the components panel, select Domain Management.

Vantage displays the Domain Management details panel (see the preceding figure).

3. To protect against potential data loss, use the Backup... button to back up the 
current domain database as described in Backing Up the Domain.

4. Click the Shrink button to shrink the database. 

A dialog pops up to explain that the Shrink command may affect database perfor-
mance and should be done only when Vantage is not busy.

A Status message indicates progress.

Current Size displays the database size next to the button, so you can see any 
changes immediately upon completion of the shrink command. 

Multiple presses of the button may shrink the database additionally each time. 
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Moving the Vantage Domain Database to Another 
Database

You might want to move the Vantage domain database because:

• You are upgrading SQL Server from Express to Standard

• You are upgrading SQL Server from an older version to a newer one

• You are moving the database from one server to another

Note: This procedure backs up the database, moves the database to a different SQL 
Server version and/or server, and restores the database. Vantage does not support a 
Vantage restore from one Vantage database version to another. If you are upgrading 
Vantage and moving the database, upgrade Vantage first, and then move the database. 

Note: This guide does not provide instructions for moving a mirrored database. 
Consult your database administrator or contact your Telestream representative 
regarding installation service options.

To move a Vantage domain database, follow the procedures in the following topics in 
the sequence presented:

1. Preparing for the Move

2. Backing up the Existing Database

3. Removing the Vantage Domain Database

4. Removing Microsoft SQL Server

5. Installing SQL Server Standard

6. Installing the Vantage Domain Database

7. Restoring the Vantage Domain Database Backup

8. Finishing the Move
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Preparing for the Move
If you are upgrading SQL Server, it is recommended but not required that you back up 
the Vantage domain database. However, if you are moving the Vantage domain 
database to a new server, you must backup the database, as the backup file will be used 
to restore the domain on the new server.

To back up the existing Vantage domain database so that it can be transferred to the 
new database later, follow these steps:

1. Use Vantage Workflow Designer to deactivate all active workflows to prevent new 
jobs from starting.

2. Use the Job Status Views tab in Vantage Workflow Designer, the Vantage Job Status 
Views web application, or Vantage Dashboard to either determine when all jobs are 
complete or stop any jobs in process or in waiting.

3. If you are moving the database to another server, do the following:

a. Take note of any Storage, Variables, and/or Qualification Rules settings for each 
service. (In the Vantage Management Console, select Services. In the service 
panel, click each service and check the tabs at the bottom of the window.)

When you move the Vantage domain database from one server to another, the 
Storage, Variable, and Qualification rule configuration for each service is lost. 
Write down any configuration that you want to transfer to the new server.

Note: The service Storage, Variable, and Qualification Rule configuration is not lost 
when you change the SQL Server version on a server. Skip to Step 4 if you are not 
moving the Vantage domain database to a different server.

b. In the Vantage Management Console, remove all services from the Vantage 
domain as described in Removing a Service from the Domain in the Vantage 
Domain Management Guide.

Note: The default Vantage user account is Administrator with no password. This 
account has administrative privileges.

c. In the Vantage Management Console, select Licenses in the components panel.
d. On the Licenses tab, select all licenses and click the Delete button .

Note: To add the licenses back a the end of this procedure, you will need access to the 
license files. If you do not know where these files are, locate them now before you 
delete them from the existing database.

4. If you are changing the Microsoft SQL version on a server (and not moving the 
database to another server), place all services in Maintenance Mode as described in 
Entering and Exiting Service Maintenance Mode.
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Backing up the Existing Database
If you are upgrading SQL Server, it is recommended that you back up the Vantage 
domain database. If you are moving the Vantage domain database to a new server, you 
must back up the database, as the backup file will be used to restore the domain on the 
new server.

To back up the existing Vantage domain database so that it can be transferred to the 
new database later, follow these steps:

1. In the Vantage Management Console, select the domain you want to modify, select 
Domain Management in the components panel, click Backup..., and use the file 
save dialog to save the backup file to a safe location.

You will need to access the backup file to restore the Vantage domain database 
after you move it. For more information, see Backing Up the Domain.

2. Close all Vantage clients, including Vantage Workflow Designer, Vantage Web 
Applications, Vantage Workflow Portal, and Vantage Management Console.

Removing the Vantage Domain Database
The Vantage Domain Database may or may not be present as a separate entry in the 
Windows Control Panel Programs and Features window, depending on how it was 
originally installed. 

In either case, the Domain Database must be removed using one of the following 
procedures:

If the Domain Database is present in the Control Panel list, remove it as follows:

1. Log into the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

Control Panel > Programs and Features > Uninstall Programs.

3. Select Vantage Domain Database and click Remove or Uninstall.

If the Domain Database is not present in the Control Panel list, remove it as follows:

1. Log into the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

Control Panel > Programs and Features > Uninstall Programs.

3. Select Vantage and click Change.

4. Deselect the check box for Vantage Domain Database and continue with removal.
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Removing Microsoft SQL Server
When you are upgrading Microsoft SQL Server or moving the Vantage domain 
database to another server, you may want to remove the old version of SQL Server. 

To remove Microsoft SQL Server, follow these steps:

1. Log into the server with a local administrator account.

2. Open the control panel tool for removing programs:
Control Panel > Programs and Features > Uninstall Programs.

3. Select Microsoft SQL Server and click Remove or Uninstall.

Note: If you are prompted to stop the SQL Server (VANTAGE) service, go to Start > 
Services and stop the service before clicking Retry to continue with uninstalling.

Note: If you have multiple instances (for example SQLEXPRESS and VANTAGE), you 
will need to remove them both.

4. Select Microsoft SQL Server Native Client and click Remove or Uninstall.

Note: Uninstalling the SQL Server does not delete your Vantage workflows, resources, 
or transaction history. It leaves your domain database files intact in 
[Install_Drive]:\Program Files\Telestream\Vantage\Database. For information on 
removing the database files, see Uninstalling Vantage from a Server in the Vantage 
Installation Guide or the Vantage Domain Management Guide.

At this point, the SQL Server is removed but the database files and any Vantage services 
and clients that were installed on the server remain installed. The domain cannot 
resume operation until the SQL Server is reinstalled on this server or set up on another 
server.
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Installing SQL Server Standard
Please see Installing SQL Server 2012 Standard, Installing SQL Server 2014 Standard, or 
Installing SQL Server 2016/2019 Standard earlier in this chapter After installing SQL, 
continue with the next topic to install the Vantage database.

Installing the Vantage Domain Database
This task installs the Vantage domain database instance. Follow these steps:

1. Log into the database server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall is off.

Note: To effectively operate Vantage services with other networked devices or 
systems, you must turn off Windows Firewall.

2. Stop the SQL Server Agent Service in Start > Services, if it is running. 

3. Run the Vantage _8.1_Setup installer. See Vantage Installers Overview for details.

4. When the Welcome dialog appears, click Next to display the license agreement. 

5. License Agreement—Click I Accept if you agree to the license terms, and then click 
Next.

6. Select Array {Multi-Node} Installation and click Next.

7. Select the type of installation you want to perform: Install Product or Custom Install. 
Install Product lists products and options in licensed groups. Custom Install lists 
every Vantage component and option and allows you to select what you want. 
Click Next.

8. Browse to Configure the installation locations for the Installation base, the default 
Vantage Store. Defaults are recommended.

9. Enable Install Vantage Database to install the Vantage database.

10. When Ready to Install appears, click Install to begin installation, which takes a few 
minutes. Progress is displayed as the installation takes place.

Note: The Vantage Setup program checks for an existing SQL Server installation, and 
if found, Setup skips the installation of SQL Server. If SQL Server is not found, SQL 
Server 2019 Express will be installed. Similarly, if no Vantage database is found, a new 
one is installed. If a Vantage database is found, it is upgraded; upgrading preserves 
workflows, design items, job history, catalogs, stores, application configurations, user 
settings, and licenses.

11. Click Next when the installer indicates it is finished. 

12. The installer displays Installation was successful! (or indicates errors if unsuccessful). 
Click Done to close the installer application. Database installation is complete.
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If you are upgrading SQL Server on the same server, the upgrade is almost complete. 
Vantage should have discovered the old database files. Now you need to finish the 
process as described in Finishing the Move. 

If the old database files are not found, or if you are installing the Vantage domain 
database on a different server, restore the database from the backup file as described in 
Restoring the Vantage Domain Database Backup.

Restoring the Vantage Domain Database Backup
To restore the Vantage domain database using the backup file you previously created, 
follow these steps:

1. Start the Vantage Management Console on any Vantage server in the domain.

Note: If you have moved the Vantage domain database to a new server, the name of 
the Vantage domain changed to the name of the new host server. 

2. In the Vantage Management Console, select the domain to modify, select Domain 
Management in the components panel, click Restore..., and select the file to restore. 
For more information, see Backing Up the Domain in the Vantage System 
Administration Guide or the Vantage Domain Management Guide.

Finishing the Move
To finish the move, you must enable the services you disabled when preparing for the 
move. If you moved the Vantage domain database to another server, you must also 
install Vantage licenses. To return Vantage to operation, follow these steps:

1. If you changed the Microsoft SQL version on a server (and did not move the 
database to another server), do the following:

a. Remove all services from Maintenance Mode as described in Entering and Exiting 
Service Maintenance Mode in the Vantage System Administration Guide or the 
Vantage Domain Management Guide.

b. Skip to Step 4.

2. If you moved the Vantage domain database to a different server, activate Vantage 
Domain licenses as follows:

a. In the Vantage Management Console, open the domain you want to modify, and 
select Licenses in the components panel.

b. On the Licenses tab, click the Add License button  and use the open file dialog 
to select the license file.

If your domain has multiple license files (for multiple features), repeat this step 
for additional licenses.
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3. If you moved the database to another server, update the configuration of services 
as follows:

a. In the Vantage Management Console, open the domain you want to modify, and 
select Services in the components panel.

b. In the Services panel, click the Add Service button  and use the dialog to select 
a service to add.

c. If any Storage, Variables, and/or Qualification Rules settings were configured for 
the service, add them now.

d. Repeat this step for each service until all services are updated.

4. Use Vantage Workflow Designer to reactivate all workflows.
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Installing Vantage 

Use this topic to perform a first-time installation and configuration of the Vantage and 
SQL Server software as well as supporting software. 

If you are upgrading an existing Vantage version, skip this chapter and go to the 
chapter on Upgrading and Modifying Vantage.

Before launching into this chapter, please be sure you have reviewed and planned for 
all requirements presented in the Before You Install Vantage chapter.

Note: To obtain the Vantage software or browse the Vantage library of user’s guides, 
application notes, and other documents, go to www.telestream.net/telestream-
support/vantage/support.htm.

The following topics are included in this chapter:

■ Installation Prerequisites and Overview

■ Installing Vantage on a Single Node

■ Installing a Vantage Array

■ Post-Installation Steps for Single Nodes and Arrays

■ Command Line Installation
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Installation Prerequisites and Overview
The following topics summarize Vantage prerequisites and provide an overview of the 
installation steps. 

■ Installation Prerequisites

■ Installation Overview

■ Extracting and Running the Installer

Installation Prerequisites
These prerequisites are required by Vantage: 

• Microsoft .NET Framework 4.8 is required on Vantage servers, client workstations, 
and Web Apps installations. This .NET version is installed automatically by the Van-
tage or Web Apps installer on all operating systems, if not already present.

• Microsoft .NET 3.5.1 is also required on Vantage servers that run the general pur-
pose Flip action and on servers running SQL Server 2014, but it is not required on 
other servers or client machines. This .NET version must be installed manually using 
Server Manager on servers that require it. After installation, open Server Manager > 
Roles > Server Roles, and check Web Server (IIS) to enable it. Then enable the ser-
vices listed in the IIS Role Service Requirements table. 

• QuickTime 7.6.9 from Apple.com is required by the Telestream Transcode & Analysis 
engine. If it is not present, the installer installs it. If it is outdated a message advises 
you to update it. You can use this link to download it: QuickTime version 7.6.9.

Note: If you prefer not to install QuickTime because of known security vulnerabilities, 
a number of Vantage functions will not operate, such as portal proxy playback and 
several Flip action functions. For details about QuickTime issues, see the Telestream 
and QuickTime statement on the Telestream.net web site.

• The Windows servers must be correctly configured, including these options:

– Desktop Experience installed (required by clients and the Analyze, Conform, and 
various Flip actions)

– UAC set as desired and correct privileges (admin or user) used to install Vantage
– Power Options set to High Performance to prevent the server from sleeping

Please see Windows Server Configuration Requirements in the Before You Install 
Vantage chapter for instructions.

Note: Automatic Windows and software updates and automatic restarts of Vantage 
servers should be disabled. Schedule update installations and system restarts only 
during planned maintenance periods to prevent disruption of Vantage operations. 

With the prerequisites installed, you’re ready to install Vantage in one of two ways: 

(1) A Single Node all-in-one domain installation (everything on one server)

http://appldnld.apple.com/QuickTime/041-0025.20101207.Ptrqt/QuickTimeInstaller.exe
http://marketing.telestream.net/acton/fs/blocks/showLandingPage/a/5268/p/p-0116/t/page/fm/0
http://marketing.telestream.net/acton/fs/blocks/showLandingPage/a/5268/p/p-0116/t/page/fm/0
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(2) An Array (Multi-Node) installation with distributed processing on multiple servers. 

Differences between the two installation types are listed below.

Note: A Vantage array requires one Vantage Array license per node. Installation of an 
array requires additional steps compared to installation on a single node.

Note: On your Vantage servers use only the Vantage_8.1_Setup.exe installer  to install 
client components. On client machines, you can use either the 
Vantage_8.1_Client_Application.msi installer or the Vantage_8.1_Setup.exe installer to 
install clients, but don’t switch installers later if you make client installation changes.

Single Node Installation Array Multi-Node Installation

• Installs Intel Performance Primitives and 
checks for QuickTime and .NET versions. 

• Installs MS SQL 2019 Express unless dese-
lected or MS SQL is already installed. 

• Automatically installs or updates 
Domain Database and SQL, if present.

• Creates Vantage Store (C:\VantageStore\), 
as well as Catalog (default), and Samples 
folders in C:\ Program Files (x86) 
\Telestream\Vantage.

• Installs the Vantage Media Transcode & 
Analysis engine, if needed.

• Installs clients: Management Console, 
Workflow Designer, Workflow Portal, 
and Dublist Portal.

• Installs Intel Performance Primitives and 
checks QuickTime and .NET versions. 

• Does not install MS SQL 2019 Express or 
install/update the Domain Database 
unless selected. MS SQL Standard is pre-
ferred (customer supplied).

• Does not create Store, Catalog, or Sam-
ples folders but does create C:\ Program 
Files (x86)\Telestream\Vantage folders.

• Installs the Vantage Media Transcode & 
Analysis engine, if needed.

• Installs clients: Management Console, 
Workflow Designer, Workflow Portal, 
and Dublist Portal.

• Installs Web Apps, if selected. 
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Installation Overview
The Vantage 8.1 installer and associated files are packaged in a zip file available from 
Telestream. See Vantage Installers Overview for details. Right-click the zip file and select 
Extract All. Follow the steps to extract the installers and related files.

The main Vantage installer is Vantage_8.1_Setup.exe. Double click on this file to start 
the installation.

The following overview and flowchart (below) summarize the main Vantage installation 
steps with links to the detailed procedures. Be sure to follow all steps in this chapter 
carefully and in sequence from the beginning of the chapter to the end. 

If you are upgrading an existing Vantage installation, skip this chapter and refer 
instead to this chapter: Upgrading and Modifying Vantage.

If you are creating a new installation, follow the steps and links below. 

1. See the Before You Install Vantage chapter in this guide to ensure your hardware, OS, 
and software meet the Vantage installation requirements. 

2. Run the Vantage _8.1_Setup installer. See Vantage Installers Overview for details.

3. Install the database and install all licensed Vantage components using the installer 
as explained in one of these two topics: 

– Single computer installation: Installing Vantage on a Single Node
– Array installation: Installing a Vantage Array

To install product feature groups (recommended) when you run the installer, select 
Install Product and select the product groups for which you have licenses, or to 
install individual components, select Custom Install and select specific components. 

4. If installing a new Vantage array, set up database access for distributed services and 
Windows log on IDs: 

– Adding Vantage Services
– Setting the Vantage Windows Log On ID for Services.

5. Continue post-installation tasks: Post-Installation Steps for Single Nodes and Arrays 

– Setting Up a Vantage Store
– Installing and Configuring Vantage Web Applications
– Enabling Vantage Licenses
– Installing Client Programs on Client Workstations
– Configuring Client DB Access and User Administration
– Verifying the Installation

6. Install Vantage updates, if any. See Updating Vantage Between New Versions in the 
Upgrading and Modifying Vantage chapter.
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Extracting and Running the Installer

1. See Vantage Installers Overview for details on obtaining the zip file. Run the 
Vantage_8.1_Setup installer. 

2. Press Next to start the installation, then follow the prompts.

3. When installation completes, the final screen shows “Installation was successful.” 
Click Done to close the installer.

Note: If you extract and copy the Setup file away from the ComponentPacs Directory 
before running it, the installation still succeeds, but no ComponentPacs are installed. If 
the server is part of a Vantage Array, the ComponentPacs are retrieved from another 
server in the Vantage Domain. Additionally, redistributable components are installed 
from the Internet rather than from the copies in the ComponentPacs Directory.
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Installing Vantage on a Single Node
An all-in-one Vantage domain is one in which all Vantage server components are 
installed and operate on a single server (node). The components include the Vantage 
software and services, the Vantage domain database, and Vantage client programs 
(Vantage Management Console, Vantage Workflow Designer, Vantage Workflow Portal, 
and Vantage Dublist Portal). Additional licensed client programs can also be installed 
separately on client workstations. 

Note: A Vantage domain with more than one node is a Vantage Array and requires 
one Vantage Array license per node. Installation differs for an array. See Installing a 
Vantage Array and skip these single node instructions.

The fastest, easiest, and recommended way to install a new Vantage installation on a 
single node is to follow the steps below to install everything at once. 

If you need to update or reinstall specific individual components, follow the 
instructions in the Upgrading and Modifying Vantage chapter.

To install all licensed Vantage components on a single server, follow these steps:

1. Log into the target server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall are off.

2. Run the Vantage_8.1_Setup installer. See Vantage Installers Overview for details.

3. When the Welcome dialog appears, click Next to display the license agreement. 

4. When the license agreement appears, click I accept the terms in the License 
Agreement (if you accept the terms), and click Next (or click Cancel).

5. Select Single Node Installation (the default) when the dialog instructs you to “Select 
the type of Vantage system you want to install on.” Then click Next.

6. Select the type of installation you want to perform: Install Product or Custom Install. 
Install Product lists products and options in licensed groups. Custom Install lists 
every Vantage component and option and allows you to select what you want. 

7. In the Install Product or Custom Install display, check the boxes by the components 
you want to install, and click Next. 

At a minimum, you should choose to install the Transcode/Transcode Pro selection. 
If licensed, you may choose multiple options that include additional services, the 
Workflow Designer, and the Workflow Portal. 

8. Browse to Configure the installation locations for the Installation base, the default 
Vantage Store, and the Vantage database. Defaults are recommended.

9. When the Ready to Install dialog appears, click Install to begin product installation. 
This process takes a few minutes to complete and shows progress and components 
being installed as it runs. See Installation Notes below for additional details.
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Note: The Vantage Setup program checks for an existing SQL Server installation, and 
if found, Setup skips the installation of SQL Server. If SQL Server is not found, SQL 
Server 2019 Express will be installed. Similarly, if no Vantage database is found, a new 
one is installed. If a Vantage database is found, it is upgraded; upgrading preserves 
workflows, design items, job history, catalogs, stores, application configurations, user 
settings and licenses.

10. When installation is complete, the progress text displays Finished. Click Next.

11. The dialog displays Installation successful! Click Done to complete the installation. 

This completes the initial Vantage installation. Vantage installs these components: 

• Microsoft SQL Server 2019 Express, including Browser, Native Client, Support Files

• Telestream Media Transcoding and Analysis

• Vantage

• Vantage Domain Database

• Client shortcuts on the desktop: Workflow Designer, Management Console, Work-
flow Designer, and Dublist Portal. 

If any components failed to install, you can run the installer again selecting a Custom 
Install and checking only the components you want to install again. 

Installation Notes
The following notes provide additional installation details:

Note: Telestream recommends that you do not use anti-virus software on Vantage 
servers. If you prefer to use anti-virus software, identify Vantage as a safe/trusted 
application. For additional information on using Vantage with anti-virus software, see 
Anti-Virus Software Recommendations. For more information on using Vantage with 
the Windows Firewall, see Firewall Guidelines.

Note: If Intel Performance Primitives (IPP) is not present, the Vantage installer installs it. 

Note: If QuickTime is not installed, the installer downloads and installs it for you if you 
have an Internet connection. If an outdated version is present or there is no Internet 
connection, the installer displays a message advising you to install it manually. The 
Telestream Transcode and Analysis engine requires QuickTime version 7.6.9. You can 
use this link to download it: QuickTime version 7.6.9. If you install QuickTime manually, 
uncheck (disable) Check for Updates, so QuickTime is not updated automatically. Then 
restart the server and re-run Vantage_8.1_Setup.exe again to continue.

http://appldnld.apple.com/QuickTime/041-0025.20101207.Ptrqt/QuickTimeInstaller.exe
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Note: Microsoft .NET Framework 4.8 is required on Vantage servers, client 
workstations, and Web Apps installations. This .NET version is installed automatically 
by the Vantage or Web Apps installer on all operating systems, if not already present.

Note: Microsoft .NET 3.5.1 is also required on Vantage servers that run the general 
purpose Flip action and on servers running SQL Server 2014, but it is not required on 
other servers or client machines. This .NET version must be installed manually using 
Server Manager on servers that require it. After installation, open Server Manager > 
Roles > Server Roles, and check Web Server (IIS) to enable it. Then enable the services 
listed in the IIS Role Service Requirements table. 

Quick Installation Check
At this point, the Vantage installation should be functioning, though not licensed. 
Vantage Management Console should be operational if you double-click the Vantage 
Management Console icon on the desktop. By default, no login is required. If you 
enable User Administration under Settings & Options > General to require a login, you 
can then log in with the user name “administrator” and no password. 

Next, continue with the following post-installation tasks:

• Post-Installation Steps for Single Nodes and Arrays 

– Setting Up a Vantage Store

– Installing and Configuring Vantage Web Applications

– Enabling Vantage Licenses

– Installing Client Programs on Client Workstations

– Verifying the Installation
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Installing a Vantage Array
A Vantage array consists of two or more Vantage components distributed among two 
or more servers for optimum speed and efficiency. Typically a Vantage array 
implements the Vantage domain database on one server and the Vantage Services, 
Transcode Engine, Clients, and Vantage Web Applications on another server. It is even 
possible to split Vantage Services and the Vantage Transcode Engine across multiple 
servers for maximum throughput and to put the Web Applications on their own server. 

To implement a Vantage domain across multiple servers, specific configurations must 
be applied to all computers that host any Vantage services or host the Vantage domain 
database for the array.

A Vantage array installation and configuration generally takes from one hour to several 
hours to install, depending on the complexity (number of servers). To install a Vantage 
array, perform the tasks in the specified order:

1. Setting Up SQL Server and the Vantage Domain Database

2. Installing Vantage Array Components

3. Adding Vantage Services

4. Setting the Vantage Windows Log On ID for Services

Note: Each Vantage domain requires one Vantage Array license per server. 

Setting Up SQL Server and the Vantage Domain Database
If you are upgrading an existing Vantage installation, you will already have SQL Server 
installed. Skip this step and go on to the next step, Installing Vantage Array Components. 

If the database is not installed, continue with this procedure.

Note: This guide does not provide instructions for installing a mirrored database and 
implementing mirroring. Consult your database administrator or contact your 
Telestream representative regarding installation service options.

Although you can install and operate the Vantage domain database and Vantage 
services on the same server (as is done in an all-in-one, single node domain), 
Telestream recommends that you use a dedicated server for the Vantage array domain 
database and that you use Microsoft SQL Server Standard instead of the SQL Server 
Express used in single node installations. 

To set up the Vantage domain database, follow these procedures in the order listed:

■ Installing SQL Server 2012 Standard

■ Installing SQL Server 2014 Standard

■ Installing SQL Server 2016/2019 Standard

■ Installing the Vantage Domain Database
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Installing SQL Server 2012 Standard
The following procedure explains how to install SQL Server 2012 Standard. If you are 
installing SQL Server 2014 or SQL Server 2016, please skip to that topic, Installing SQL 
Server 2014 Standard or Installing SQL Server 2016/2019 Standard.

Follow these steps to install SQL Server:

1. Log into the target server with a local administrator account.

2. Insert the SQL Server 2012 Standard DVD into the server’s DVD drive and start the 
installer (setup.exe) if it does not run automatically.

3. SQL Server Installation Center—Click Installation in the left column, then select 
New installation or add features to an existing installation.

4. Setup Support Rules—Click OK.

5. Product Key—Enter your product key and click Next.

6. License Terms—Accept the license terms and click Next.

7. SQL Server Updates—Click Next after updates have completed.

8. Setup Support Files—Click Install, allow the installer to complete its actions, and click Next.

9. Feature Selection—Check Database Engine Services and Management Tools, and click Next.

10. Instance Configuration:

a. Select Named instance.
b. Enter VANTAGE in the Named instance field and the Instance ID field.
c. Click Next to continue.

11. Disk Space Requirements—Click Next to continue.

12. Server Configuration:

a. For SQL Server Agent, the Startup Type should be disabled. (If the Startup Type is 
set to automatic, the service must be stopped before running Vantage Setup.)

b. For Server Database Engine, select NT AUTHORITY\NETWORK SERVICE
c. Click Next to continue.

13. Database Engine Configuration:

a. Click Add Current User.
b. Select Mixed Mode.
c. Enter the Vantage sa user password (vantage12!) in the Enter Password and 

Confirm Password fields.
d. Click Next to continue.

14. Continue to click through the installer windows accepting the default settings to 
complete installation.

15. Complete—Click Close to close the SQL Server 2012 Standard installer.
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16. Select Start > SQL Server Management Studio.

17. Connect to the Vantage domain database using the following information:

Server type: Database Engine
Server name: [hostname]\VANTAGE
Authentication: SQL Server Authentication
Login: sa
Password: vantage12!

18. In the Object Explorer panel, right-click [hostname]\VANTAGE and select Properties.

19. In the Server Properties window, go to the Memory page.

20. Set the Maximum server memory (in MB) to 75% of the system's memory. For 
example: If the system's memory is 8 GB (8192 MB), then the maximum server 
memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).

21. Click OK.

22. Close the SQL Server Management Studio.

Now that SQL Server Standard is installed and configured for Vantage, install the 
Vantage domain database as explained in this topic: Installing the Vantage Domain 
Database. The Vantage installer will detect that SQL Standard is already installed, will 
not install SQL Express, and will attach to the installed instance.
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Installing SQL Server 2014 Standard
Follow these steps to install SQL Server 2014 Standard on a server (skip this topic if you 
already installed another version of SQL Server):

1. Launch setup from the SQL Server 2014 Standard installation media.

2. In the SQL Server Installation Center, go to Installation on the left.

3. Select New SQL Server Stand-alone installation or add features to an existing 
installation.

4. On the Product Key page, enter a product key and click Next.

5. Accept the license terms and click Next.

6. Click Next on the Microsoft Update page.

7. On the Setup Role page, select SQL Server Feature Installation and click Next.

8. On the Feature Selection page, enable Database Engine Services, Management Tools 
– Complete and click Next.

9. On the Instance Configuration page, select Named instance, enter VANTAGE and 
click Next.

10. On the Server Configuration page, click the cell for the account name of the SQL 
Server Database Engine service. After selecting the cell, click the drop-down list and 
select <<Browse…>>.

11. In the Enter the object name to select field, type NETWORK SERVICE and click OK. 
Then click Next on the Server Configuration page.

12. On the Database Engine Configuration page, select Mixed Mode (SQL Server 
authentication and Windows authentication). Enter vantage12! for the password and 
click the Add Current User button. 

13. (Optional) If you would like to specify a non-default location for the database files, 
go to the Database Engine Configuration page, select the Database Directories tab, 
and change the Data root directory path.

14. Click Next on the Database Engine Configuration page.

15. Click install on the Ready to Install page.

16. When installation completes, click Close and close the SQL Server Installation 
window.

17. From the Start menu, launch the SQL Server 2014 Management Studio.

18. In the Server name field, enter .\vantage as the server name.

19. Set authentication to SQL Server Authentication.

20. Enter sa for the login and vantage12! for the password.

21. In the Object Explorer panel, right click .\vantage (SQL Server 12.0.2000 – sa) and 
select Properties.

22. From the Select a page panel, go to Memory and set Maximum server memory (in 
MB) to 75% of the host system’s memory. For example, if the system's memory is 8 
GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB 
(6144 MB) (8192 x 0.75 = 6144).
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23. Click OK to close the Microsoft SQL Server Management Studio window.

Now that SQL Server Standard is installed and configured for Vantage, install the 
Vantage domain database as explained in this topic: Installing the Vantage Domain 
Database. The Vantage installer will detect that SQL Standard is already installed, will 
not install SQL Express, and will attach to the installed instance.

Installing SQL Server 2016/2019 Standard
Follow these steps to install SQL Server 2016 SP1 Standard or SQL Server 2019 Standard 
on a server (skip this topic if you have already either of these versions installed):

1. Launch setup from the SQL Server 2016/2019 Standard installation media.

2. In the SQL Server Installation Center, select Installation on the left.

3. Select New SQL Server Stand-alone installation or add features to an existing 
installation.

4. On the Product Key page, enter a product key and click Next.

5. Accept the license terms and click Next.

6. Click Next on the Microsoft Update page and the Install Rules page.

7. On the Feature Selection page, click Feature Selection on the left, enable Database 
Engine Services and click Next. 

8. On the Instance Configuration page, select Named instance, enter VANTAGE and 
click Next.

9. Click the cell where the SQL Server Database Engine Row and Account Name 
column intersect. After selecting the cell, click the drop-down list and select 
<<Browse…>>. 

10. In the Enter the object name to select field, type NETWORK SERVICE and click OK. 
Then click Next on the Server Configuration page. 

11. On the Database Engine Configuration page, select Mixed Mode (SQL Server 
authentication and Windows authentication). Enter vantage12! for the password and 
click the Add Current User button. 

12. (Optional) If you would like to specify a non-default location for the database files, 
go to the Database Engine Configuration page, select the Data Directories tab, and 
change the Data root directory path.

13. Click Next on the Database Engine Configuration page.

14. Click Install on the Ready to Install page.

15. When installation completes, click Close and close the SQL Server Installation 
window.
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Installing SQL Server Management Studio

Management Studio is not automatically installed for SQL Server 2016/2019. To install 
and configure it, follow these steps:

1. Launch setup from the SQL Server 2016/2019 Standard installation media, if it is not 
still running after completing your SQL Server installation.

2. In the SQL Server Installation Center, select Installation on the left, and select Install 
SQL Server Management Tools on the right.

3. On the Welcome screen, click Install.

4. Click Restart when prompted to complete installation setup.

5. From the Start menu, launch the SQL Server Management Studio.

6. In the Server name field, enter .\vantage as the server name.

7. Set authentication to SQL Server Authentication.

8. Enter sa for the login and vantage12! for the password.

9. In the Object Explorer panel, right click .\vantage (SQL Server 12.0.2000 – sa) and 
select Properties.

10. From the Select a page panel, go to Memory and set Maximum server memory (in 
MB) to 75% of the host system’s memory. For example, if the system's memory is 8 
GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB 
(6144 MB) (8192 x 0.75 = 6144).

11. Click OK to close the Microsoft SQL Server Management Studio window.

Now that SQL Server Standard is installed and configured for Vantage, install the 
Vantage domain database as explained in this topic: Installing the Vantage Domain 
Database. The Vantage installer will detect that SQL Standard is already installed, will 
not install SQL Express, and will attach to the installed instance.
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Installing the Vantage Domain Database
This task installs the Vantage domain database instance.

Note: Telestream recommends that you install the database on a different hard drive 
from the one allocated for temporary media storage. For details, see Database 
Selection and Configuration Guidelines in the Before You Install Vantage chapter.

Follow these steps:

1. Log into the database server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall is off.

Note: To effectively operate Vantage services with other networked devices or 
systems, you must turn off Windows Firewall.

2. Stop the SQL Server Agent Service in Start > Services, if it is running. 

3. Run the Vantage_8.1_Setup installer. See Vantage Installers Overview for details.

4. When the Welcome dialog appears, click Next to display the license agreement. 

5. License Agreement—Click I Accept if you agree to the license terms, and then click 
Next.

6. Select Array {Multi-Node} Installation and click Next.

7. Select the type of installation you want to perform: Install Product or Custom Install. 
Install Product lists products and options in licensed groups. Custom Install lists 
every Vantage component and option and allows you to select what you want. 
Click Next.

8. Browse to Configure the installation locations for the Installation base, the default 
Vantage Store. Defaults are recommended.

9. Enable Install Vantage Database if you wish to install the Vantage database.

10. When Ready to Install appears, click Install to begin installation, which takes a few 
minutes. Progress is displayed as the installation takes place.

Note: The Vantage Setup program checks for an existing SQL Server installation, and 
if found, Setup skips the installation of SQL Server. If SQL Server is not found, SQL 
Server 2019 Express will be installed. Similarly, if no Vantage database is found, a new 
one is installed. If a Vantage database is found, it is upgraded; upgrading preserves 
workflows, design items, job history, catalogs, stores, application configurations, user 
settings and licenses.

11. Click Next when the installer indicates it is finished. 

12. The installer displays Installation was successful! (or indicates errors if unsuccessful). 
Click Done to close the installer application. Database installation is complete.
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Note: Existing workflows do not require updating to run as they did on earlier 
Vantage releases. However, you can update actions and workflows to take advantage 
of new features. See the Vantage User Guide for details.
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Installing Vantage Array Components
Once you have your SQL database and Vantage Domain Database installed, you’re 
ready to install the Vantage Array components, including Vantage services, transcoders, 
and clients. Telestream recommends that you install these components on a different 
server than your database for maximum operating efficiency.

Note about the Cloud Service: In a Vantage array, each node that will process Cloud 
jobs must have the following installed: Vantage, the Cloud Service, the Transcoding 
Services (IPTV, Post Producer, Transcoder, Analysis, Multiscreen, and Timed Text) and at 
least one ComponentPac. 

Once the associated Vantage service was installed, the job completed successfully.

To install the Vantage components, follow these procedures in the order presented:

1. Installing Vantage Services, Transcode Engine, and Clients

2. Adding Vantage Services

3. Setting the Vantage Windows Log On ID for Services

Installing Vantage Services, Transcode Engine, and Clients
This procedure installs the Vantage services, Transcode & Analysis Engine, Vantage 
Management Console, and Vantage Workflow Designer on a server. If you prefer, you 
can divide these components among multiple servers for greater processing efficiency. 
To do so, select only the components you want to install on the current server when 
you perform step 7 below.

Note: Vantage installers modify Windows Distributed Transaction Coordinator 
(MSDTC) properties to meet Vantage services and database communication 
requirements. This modification is automatic, and requires no action on your part.

To install the Vantage components, do the following:

1. Log into the target server with a local administrator account. Make sure that virus-
checking software and Windows Firewall are turned off.

Note: Telestream recommends not using anti-virus software on Vantage servers. If 
you use anti-virus software, you should identify Vantage as a safe/trusted application. 
Be sure to turn off anti-virus software during Vantage installation or install anti-virus 
software after installing Vantage.

2. Run the Vantage _8.1_Setup installer. See Vantage Installers Overview for details.

3. When the Welcome dialog appears, click Next to display the license agreement.

4. When the license agreement appears, click I accept the terms in the License 
Agreement (if you accept the terms), and click Next (or click Cancel).
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5. Select Array {Multi-Node} Installation when the dialog instructs you to “Select the 
type of Vantage system you want to install.” Then click Next.

6. Select the type of installation you want to perform: Install Product or Custom Install. 
Install Product lists products and options in licensed groups. Custom Install lists 
every Vantage component and option. 

7. In the Install Product or Custom Install display, check the boxes by the components 
you want to install, and click Next. 

At a minimum, you should choose to install the Transcode/Transcode Pro selection. 
If licensed, you may choose multiple options that include additional services, the 
Workflow Designer, the Workflow Portal, and Web Applications. 

Note: If Vantage Web Applications have never been installed and you are not 
installing them on a Lightspeed server, leave them unchecked in the installer and 
install them later as explained in Installing and Configuring Vantage Web Applications. If 
they have been installed before (and IIS is already configured), or you are installing on 
a Lightspeed server, you can check the installer to install them now.

8. Browse to Configure the installation location for the Installation base.

9. When the Ready to Install dialog appears, click Install to begin product installation. 
This process takes a few minutes to complete and shows progress and components 
being installed as it runs. See Installation Notes below for additional details.

10. When installation is complete, the progress text displays Finished. Click Next.

11. The dialog displays Installation successful! Click Done. 

This completes the initial Vantage installation. Vantage 8.1 is now visible in the Control 
Panel > Programs and Features list, and Vantage should be functional, though not 
licensed. To test this, launch the Vantage Management Console from its desktop icon. 

If any components failed to install, you can run the installer again selecting a Custom 
Install and checking only the components you want to install again.
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Installation Notes
The following notes provide additional installation details:

Note: Telestream recommends that you do not use anti-virus software on Vantage 
servers. If you prefer to use anti-virus software, identify Vantage as a safe/trusted 
application. For additional information on using Vantage with anti-virus software, see 
Anti-Virus Software Recommendations. For more information on using Vantage with 
the Windows Firewall, see Firewall Guidelines.

Note: If Intel Performance Primitives (IPP) is not present, the Vantage installer installs it. 

Note: If QuickTime is not installed, the installer downloads and installs it for you if you 
have an Internet connection. If an outdated version is present or there is no Internet 
connection, the installer displays a message advising you to install it manually. The 
Telestream Transcode and Analysis engine requires QuickTime version 7.6.9. You can 
use this link to download it: QuickTime version 7.6.9. If you install QuickTime manually, 
uncheck (disable) Check for Updates, so QuickTime is not updated automatically. Then 
restart the server and re-run Vantage_8.1_Setup.exe again to continue.

Note: Microsoft .NET Framework 4.8 is required on Vantage servers, client 
workstations, and Web Apps installations. This .NET version is installed automatically 
by the Vantage or Web Apps installer on all operating systems, if not already present.

Note: Microsoft .NET 3.5.1 is also required on Vantage servers that run the general 
purpose Flip action and on servers running SQL Server 2014, but it is not required on 
other servers or client machines. This .NET version must be installed manually using 
Server Manager on servers that require it. After installation, open Server Manager > 
Roles > Server Roles, and check Web Server (IIS) to enable it. Then enable the services 
listed in the IIS Role Service Requirements table. 

Note: When a service joins a domain, if it is unable to acquire an array license, it 
remains in maintenance mode and logs an error. See the Vantage Management 
Console > Support Utilities > Error Log.

http://appldnld.apple.com/QuickTime/041-0025.20101207.Ptrqt/QuickTimeInstaller.exe
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Adding Vantage Services
When Vantage services are installed on a server, the installer looks for the Vantage 
domain database on the server. If the Vantage domain database is present, all services 
are configured to connect to that domain. If no Vantage domain database is present, 
the Vantage services are not configured, and you must configure each service to 
connect to the appropriate Vantage domain. 

To add Vantage services to a Vantage domain, follow these steps:

1. Start the Vantage Management Console by double-clicking its desktop icon, select 
the domain to manage, and log in. 

Note: The default Vantage user account is Administrator with no password. This 
account has administrative privileges.

2. Select Services in the component (left) panel.

The Services details (right) panel shows all services on all servers that are con-
nected to the domain you selected.

3. Click the Add Service button  to display the Select Service dialog. 

The Select Service dialog lists all Vantage services running in this subnet, and the 
list includes unassigned services and services running on other Vantage domains.

4. Select one or more services to add to this domain, and click OK to add them.

Services are identified by name, machine or host, and Vantage domain. Make sure 
that you do not select services that are properly attached to another domain. To 
select multiple services, use shift-click to select a series of services, or use Ctrl-click 
to select individual services.

If you are moving a service from one domain to another, the Vantage Management 
Console displays the Reassign Services window. Click OK to add them to this domain.

Continue now with the next task: Setting the Vantage Windows Log On ID for Services.
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Setting the Vantage Windows Log On ID for Services
After installation, the default log on ID for each Vantage service is the Local System 
account. This log on ID provides access to files on the local server only. If a service, such 
as Transcode, requires access to files on another server, the Local System account 
cannot provide that access. If Vantage services need access to input folders, output 
folders, or a Vantage store that is on another computer, you must do the following:

• Create a Vantage Windows user ID for the service.

• Grant access to the Vantage Windows user ID on the other computers.

For more information, see Windows Authentication Guidelines.

Most Vantage services require a Vantage Windows user ID to access files on other 
computers.

For services of the same type, the Windows log on ID for that service must be the same 
on all Vantage servers in the domain. For example, all Analysis services within the 
domain must use the same log on ID. However, the Catalog service, which does not 
access files, can remain set to use the Local System account.

To change the log on ID for a Vantage service, do the following for that service on each 
Vantage server in the array:

1. In the Vantage Management Console, click Services in the left panel.

2. Select a service in the list (Shift-click or Ctrl-click to select multiple services). 

3. Click the Change Service Logon button  or right-click and select Change Service 
Log On. A dialog opens, requesting the logon. 

4. Select Local System account to use the account currently accessing Vantage from 
your local machine, or select This account and fill in the user name and password for 
the account that has access to the desired network location. 

5. Click OK. A message confirms that the logon is changing.

Note: Changing a service logon restarts that service. Also note, when changing the 
logon for multiple services simultaneously, some services may not restart properly. If 
this occurs, go to Start > Services on the server, select the affected services, and click 
(or right-click) Restart to manually restart the services.

6. Grant file access to the new user on all Vantage servers that the service must access.
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Quick Installation Check
At this point, the Vantage installation should be functioning, though not licensed. 
Vantage Management Console should be operational if you double-click the Vantage 
Management Console icon on the desktop. By default, no log in is required. If you 
enable User Administration under Settings & Options > General to require a login, you 
can then log in with the user name “administrator” and no password. 

Vantage Web Apps should also start if you enter the following URL in a browser on the 
server: http://[server name]/Vantage/.

Next, continue with the following post-installation tasks:

• Post-Installation Steps for Single Nodes and Arrays 

– Setting Up a Vantage Store

– Installing and Configuring Vantage Web Applications

– Enabling Vantage Licenses

– Installing Client Programs on Client Workstations

– Configuring Client DB Access and User Administration

– Verifying the Installation
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Post-Installation Steps for Single Nodes and Arrays
This section includes post-installation procedures common to both Vantage Single 
Node and Vantage Array installations. After the initial installation is finished, continue 
with these steps: 

■ Setting Up a Vantage Store

■ Installing and Configuring Vantage Web Applications

■ Enabling Vantage Licenses

■ Installing Client Programs on Client Workstations

■ Configuring Client DB Access and User Administration

■ Command Line Installation

■ Verifying the Installation
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Setting Up a Vantage Store
A Vantage store is a required folder that serves as a temporary location to store media 
files while Vantage processes them. It is used by the transcoders and the Workflow 
Portal (including Web Apps Workflow Portal) and must be in place before you use the 
domain. A Vantage array installation does not automatically set up a Vantage Store, so 
you will need to create one now. An all-in-one, single-node installation creates a default 
storage location at C:\VantageStore\ and also creates a Vantage catalog. However, you 
may prefer to set up a more convenient location for processing your Vantage jobs. 

To create a Vantage Store, follow these steps: 

1. If you have not created a Windows share to serve as the Vantage store, create it now 
and make it available to the Vantage Windows user. For more information, see 
Configuring Folders for Vantage Access.

2. Open the Vantage Management Console.

3. Click Storage in the left panel to display the Vantage storage options.

4. Select Vantage Stores to display the Vantage Stores list in the details (right) panel.

5. Click the New Vantage Store toolbar button  to open the Add New Store dialog.

6. Type a name for the store in the Name text box.

The name that you enter here is the name that appears in Workflow Designer when 
an action is configured to access a media file or attachment.

7. To specify the store root directory, do the following:

a. Click Modify to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the store.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

Notes: If you use a local drive letter to specify a directory, only Vantage services and 
clients on the same computer can access the store. If the Vantage store is on a different 
computer, you must publish a share and grant access to the appropriate Windows 
users before it will appear in the Browse for Folder dialog. For more information, see 
Windows Authentication Guidelines in the Before You Install Vantage chapter.

8. Click the Save button  to save the new store.
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Installing and Configuring Vantage Web Applications
Vantage Web Applications (for Vantage arrays only) provide convenient operator and 
administrator browser-based access to Vantage without the overhead of running the 
full Vantage clients. Functions include the Dashboard, Job Status Views, Workflow 
Portal, Dublist Portal and Live Capture. When planning Web Apps installation, it is 
recommended that you run them on a separate server from the Transcoder & Analysis 
Engine with the firewall enabled, since users may be accessing the Web Apps remotely. 

If you are updating existing Web Apps, the server is already configured. See Updating 
Vantage Web Applications for an abbreviated procedure.

If you are installing Web Applications for the first time, use the following procedure. 

The following topics explain Web Application installation and configuration:

■ Installing Vantage Web Applications

■ Using Web Apps with Active Directory

■ Managing Web Workflow Portal Client Alias Support

■ Bypassing Database Login

■ Enabling Vantage Licenses
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Installing Vantage Web Applications
When installing the Vantage Web Applications on a server for the first time, the 
procedure is different for Lightspeed servers and standard servers:

• Standard servers—You must set up IIS first. If IIS is already installed, you must create 
the configuration that supports Vantage Web Applications. Start at Step 1 below.

• Lightspeed servers—Lightspeed servers ship with IIS properly installed. There is no 
need to set up IIS on a Lightspeed server. Skip the steps below and see Updating 
Vantage Web Applications for an abbreviated installation procedure.

To install IIS and the Vantage Web Applications, follow these steps:

1. Log on to the target server with a local administrator account. 

2. If you are installing on a Lightspeed server, skip to Step 5.

3. Verify that your IIS server and .NET framework requirements are met (also see 
Vantage Web Applications OS): 

– IIS 8.0 or later is required.

– .NET 4.8 is required.

Note: .NET 4.8 is installed by the Web Apps installer if it is not already present.

4. Install and/or configure IIS on the target server:

a. Open the Control Panel Administrative tools, and open the Server Manager.
b. Make these selections to install and configure:

Install—Server Manager > Local Server > Roles and Features > Add Roles & Features.

- Installation Type: Role-based or feature based installation > Next.
- Server Selection: Select a server from the server pool > LOCAL SERVER > Next.
- Server Roles: Web Server IIS + Management Tools > Add Features > Next.
- Features: Select .NET Framework 3.5 Features > Next. 

Configure—Role Services: Enable services listed in the following table and press 
Next.

- Confirmation: Click Specify an alternate source path and enter the path of the SxS 
folder located in the Sources folder on the Server 2012/2016 installation disc 
(example: D:\sources\sxs).

- Click Install, and after installation finishes, press Close.
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5. Run the Vantage_8.1_Setup.exe installer to begin Web Apps installation. Choose an 
Array > Custom installation, and check the box to install only the Web Applications 
(all else unchecked). 

Alternatively, you can run the separate VantageWebApplicationsSetup.exe installer. 

IIS Role Service Requirements

Service Install/Select Uninstall/Deselect
Common HTTP 
Features

Static Content
Default Document
Directory Browsing
HTTP Errors

HTTP Redirection
WebDAV Publishing

Application 
Development 

.NET Extensibility 4.5/4.6 
ASP.NET 4.5/4.6
ISAPI Extensions
ISAPI Filters

.NET Extensibility 3.5
Application Initialization
ASP
ASP.NET 3.5
CGI
Server Side Includes
WebSocket Protocol

Health and 
Diagnostics

HTTP Logging
Request Monitor

Logging Tools
Tracing
Custom Logging
ODBC Logging
Tracing (2016)

Security Request Filtering Basic Authentication
Windows Authentication
Digest Authentication
Client Certificate Mapping 
Authentication
IIS Client Certificate 
Mapping Authentication
URL Authorization
IP and Domain Restrictions

Performance Static Content Compression Dynamic Content 
Compression

Management Tools IIS 6 Management Console
IIS 6 Management 
Compatibility 
IIS 6 Metabase Compatibility
IIS 6 WMI Compatibility
IIS 6 Scripting Tools
IIS 6 Mgmt. Console

IIS Management Scripts and 
Tools
Management Service

FTP server FTP server
FTP Service
FTP Extensibility

IIS Hostable Web Core IIS Hostable Web Core



Installing Vantage
Post-Installation Steps for Single Nodes and Arrays

99

Note: Ideally the Vantage Web Apps should be installed on a different server from 
any of the services which perform transcoding. However, you can put both on a single 
node if necessary. Also note: Run the Web Apps installer after you have used the 
Vantage_8.1_Setup.exe installer to install other Vantage components. Running the 
Vantage_8.1_Setup.exe installer after the Web Apps installer removes the Web apps.

6. When the Welcome Window appears, click Next.

7. Click I accept... to accept the license terms after reading them, and click Next (or 
click Cancel if you do not agree to the license terms).

8. When the Select Installation Address dialog appears, click Next to accept the 
default configuration, or change the settings as required, and click Next.

Note: Ensure the Application Pool drop-down selection is set to create Vantage 
Application Pool. 

9. Click Install to begin installation.

10. When the Installation Complete dialog appears, click Finish.

11. If Vantage services were running before the Vantage Web Applications installation, 
restart them using Microsoft Services (Start > Administrative Tools > Services).

12. Provide the Vantage Web Applications login requirements to each of your Vantage 
users, so that they know how to access them. The URL for the Vantage Web 
Applications is: http://[hostname]/Vantage where [hostname] is the server where 
you installed them.

Note: For information on the browser requirements for Vantage Web Applications, 
see Vantage Web Applications Browser Requirements.

Note: If your installation uses the Workflow Portal Web application, configure 
support for this program as described in Managing Web Workflow Portal Client Alias 
Support.

Using Web Apps with Active Directory
If you are using Vantage with Active Directory enabled in Vantage Management 
Console Settings & Options, you may receive a server error message when you attempt 
to log into Vantage Web Apps. To resolve this issue, you must set up IIS for ASP.NET 
Impersonation. 

ASP.NET Impersonation assigns one special account as the authentication account for 
Web Apps with all necessary privileges and allows Vantage users to log in using that 
account. For example, you might create the Windows account called WebAppsUser on 
the server where the Web Apps are installed. You then assign that user the desired 
Windows permissions, which must include assignment to the local administrators group. 
Finally, set up impersonation as described below. With impersonation operating, when 
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Vantage users access the IIS server to run the Web Apps, IIS substitutes the credentials 
from the special account to log them into IIS and allow access to the Web Apps. 

To set up ASP.NET impersonation for the Web Apps, follow these steps:

1. Create a Windows Active Directory account with local administrator privileges to act 
as the impersonator on the IIS server where the Web Apps are installed.

2. Click Start and enter IIS in the Search Programs field. Then select Internet 
Information Services Manager from the list of search results.

3. In the IIS Connections panel, expand the top tier (hostname), expand Sites, Expand 
Default Web Site, and click Vantage.

4. In the IIS group under Vantage Home in the center panel, double-click 
Authentication. The Authentication panel opens (the ASP.NET Impersonation in IIS 
figure).

5. Right-click ASP.NET Impersonation, and select Enable. The state of this feature 
changes to Enabled.

6. Right-click ASP.NET Impersonation, and select Edit.

7. Select Specific User, and click Set....

8. Fill in the User Name and password for the Active Directory user created in step 1 to 
use for logging into the Web Apps, and click OK.

Now when authorized Vantage users log into the Web Apps, IIS impersonates the local 
admin user you specified and allows the Vantage users Web Apps access.

ASP.NET Impersonation in IIS
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Managing Web Workflow Portal Client Alias Support
The Vantage Workflow Portal Web application requires HTTP access to Vantage stores 
for viewing of proxy media files using the automatically installed HTML5 Video Player 
on client computers. If your Vantage installation does not use the Workflow Portal Web 
client, or if operators will not be using the Workflow Portal Web client to view proxy 
files, you do not need to configure alias support.

Providing HTTP access to Vantage stores for proxy viewing requires the following:

• Create and configure a virtual directory on the IIS server that references the Van-
tage store. A virtual directory must be created for every store that will store proxy 
files for the Workflow Portal Web application.

• Create and configure a Vantage alias for the virtual directory.

• Create and configure a Workflow Portal configuration using the Vantage Manage-
ment Console to support operator management.

• Install the HTML5 Video Player on computers that will view proxy media files using 
the Workflow Portal Web application. This happens automatically when you install 
the Vantage Web Applications including the Workflow Portal Web App.

The following topics describe how to manage an alias for a Vantage store:

■ Creating an IIS Virtual Directory

■ Creating an Alias for Each Vantage Store in the Vantage Management Console

■ Modifying an Alias

■ Deleting an Alias

Creating an IIS Virtual Directory

For detailed instructions to create an IIS virtual directory, refer to the Microsoft IIS 
product documentation. The following procedure provides an example of how to 
configure a virtual directory on an IIS server:

1. If not already installed, install the Vantage Web Applications as described in 
Installing and Configuring Vantage Web Applications.

2. On the server that hosts the Vantage Web Applications, select Start > 
Administrative Tools > Computer Management.

3. In the left panel of the Computer Management window, expand Services and 
Applications and select Internet Information Services (IIS) Manager.

4. In the Connections panel, expand the server entry, and expand the Sites entry.

Note: In some situations, adding or removing a virtual directory causes Web 
Dashboard sessions to close. This does not change the Web Dashboard configuration 
or operation. Web Dashboard users can simply restart the program.

5. Right click Default Web Site and select Add Virtual Directory.
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6. Configure the virtual directory as follows:

a. Enter an Alias name for the virtual directory.

Consider using a name that is easy to associate with the Vantage store directory, 
and note this name, as you will need to use it to create a Vantage alias.

b. Type the path to the Vantage store directory in the Physical path text box, or click 
the browse button to the right of the text box and select a directory.

For an all-in-one domain, the path to the default Local Store is C:\VantageStore. 
The default path works only when the store and the Vantage Web Applications 
are located on the same server.

If your Vantage store is located on a network attached storage device or other 
network accessible location, enter the UNC path to the location (for example, 
//myserver/myStore/).

c. Click Connect as, click Specific user, and click Set.
d. Enter user name and password information for a Windows user with access to the 

Vantage store directory, and click OK twice.

If required, the user name should include a domain name. For example, 
user@domain.net or VantageGuru@MyCompany.net. You can also enter 
<domain>\user.

Note: If you are operating in a Windows workgroup, the IIS server machine name and 
the machine name of the file share for the Vantage store should have the same local 
account name (VantageUser, for example) and password. This allows for easy 
authentication from IIS to the Vantage store location. In this case, the user name in the 
Set Credentials window can be specified simply as VantageUser.

e. Click Test Settings.

The Test Connection dialog should show that the Authentication and Authoriza-
tion tests passed.

f. Click Close.
g. Click OK to complete the virtual directory configuration.

The virtual directory should now display in the Computer Management window 
as a folder below the Web site you modified.

h. Repeat this procedure for all Vantage stores that will store proxy files for use with 
the Workflow Portal Web application.
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Creating an Alias for Each Vantage Store in the Vantage Management Console

After you create virtual directories for your Vantage stores, you need to create a 
Vantage alias in the Vantage Management Console for each Vantage store that will 
store proxy files:

1. Start the Vantage Management Console, select the domain to manage, and log on.

Note: The default Vantage user account is administrator with no password. This 
account has administrative privileges.

2. Select Storage in the left panel, and Vantage Stores in the main panel.

3. Create a new store or click an existing store in the Vantage Stores list.

4. In the Alias field, enter the virtual directory alias you created in the previous 
procedure: http://IIShostname/Virtual Directory.

5. Click the Save button  to save the changes.

6. Repeat this procedure for all Vantage stores that will store proxy files for use with 
the Workflow Portal Web application.

Modifying an Alias

After you have created an alias, you can modify the alias path by simply typing in the 
Alias field and saving the changes. 

Deleting an Alias

To delete an alias, select the alias path in the Alias text box, press Delete, and save.

Bypassing Database Login
To keep database credentials secure and simplify operator login, an administrator can 
configure operator accounts to automatically log into the database without showing 
the login and password. To configure this option, log in as an administrator, select 
Settings, check (enable) Preconfigure Vantage Database, and click Save. 
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Enabling Vantage Licenses
If you are implementing Vantage in a new production environment or you did not back 
up your previous database, enable your new licenses now using this procedure. If you 
have not yet obtained a license or if you need additional licenses, contact Telestream.

The following topics describe Vantage license installation:

■ Installing a Vantage License

■ Activating a Vantage License Offline

■ Troubleshooting License Installation Problems

■ Resolving a DEP Conflict

Note: A Vantage domain with two or more nodes requires one Vantage Array license 
for each node. Additional licenses are required to activate optional features.

Installing a Vantage License

Note: You should remove a license from one domain before you use it in another 
domain—you cannot use the same license in more than one domain at a time. 

Also note that you can install demo licenses as described below or by using the 
Workflow Designer File > Add/Update Demo License... menu selection. See the Vantage 
User Guide for details.

When you receive a license (an XML file), install it using these steps:

1. Store a copy of the license file in a safe place. 

Always keep a backup in case you need to move the database later.

2. Store a copy of the license file in a location that is accessible to the server where 
you are installing the license, and note the directory where the file is stored. 

3. Start the Vantage Management Console by double-clicking its desktop icon.

4. In the left panel, select Licenses.

5. In the right panel, click the Add/Update a license button  in the toolbar to display 
the Add/Update License dialog.

6. Navigate to the folder containing the licenses, select the licenses, and click Open.

If this computer has an Internet connection, Vantage prompts you to accept the 
license agreement. If an error message appears, see Troubleshooting License Installa-
tion Problems.

7. Click I Accept... if you agree to the license terms, and click OK.

8. When the Licensing Changed dialog appears, read the message and click OK.

9. Repeat this procedure to install additional licenses.

When installation is complete, the license is stored in the Vantage domain database for 
use by all Vantage services and clients in the domain. Telestream recommends that you 
archive a copy, in case you need to move the license to another Vantage domain later.
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Activating a Vantage License Offline
If the computer has no Internet connection, an error message displays, indicating the 
problem. The Vantage Management Console might not have access to the Internet, or 
the network firewall might be prohibiting Web server (HTTP) traffic.

You can activate the Vantage license yourself using a different computer, or you can call 
Telestream Customer Service and they will assist you to activate your license. 

To activate your license with a different computer, do the following:

1. Click Cancel to continue. Vantage displays the product activation dialog.

2. Click the option to activate using a different computer and click Next. 

Vantage displays a dialog to activate using another computer, including the instal-
lation ID for your license.

3. Click Save and create a text file that contains the activation key.

4. Save this file locally and copy this file to a computer with Internet access or save it 
directly to a share on (or accessible to) a computer which has Internet access. 

After saving the file, leave the dialog open and proceed to the computer with Inter-
net access to validate the Installation ID.

5. On the computer with Internet access, open a web browser and navigate to the 
URL listed in the Offline Activation Required dialog.

6. Open the installation ID text file and copy and paste the Installation ID into the 
Installation ID field on the web page.

7. Click Submit – Vantage connects to the licensing server. 

The licensing server validates the installation ID and returns a page displaying your 
unique activation key composed of ten groups of numbers and letters. 

8. If your Vantage server is not immediately adjacent, print this page or write down 
the activation key.

9. Return to the Vantage server you wish to activate, enter the activation key in the 
licensing dialog, and activate the license.

The activation key should be accepted and the Vantage license activated, as con-
firmed by a dialog.
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Troubleshooting License Installation Problems
These are common problems that might occur during license installation:

• General licensing engine failure—the licensing server may be momentarily unavail-
able; wait one to two minutes, and then repeat the license procedure.

• No Internet connection—see Activating a Vantage License Offline.

• Data Execution Prevention (DEP) conflict—see Resolving a DEP Conflict.

Resolving a DEP Conflict
If Vantage displays an error saying that licensing cannot run with Data Execution 
Prevention enabled, follow these steps:

1. Right-click My Computer to display the System Properties dialog.

2. On the Advanced tab, click the Performance Settings button to display the 
Performance Options window.

3. On the Data Execution Prevention tab, check Turn on DEP for all programs and 
services except those I select.

4. Click Add and navigate to the Vantage Management Console executable: 
(C:\Program Files (x86)\Telestream\Vantage\VantageManagementConsole.exe).

5. Click Open, and click OK to apply this change.

6. Click OK to restart the computer and activate the license.

The activated license is stored in the Vantage domain database for use by Vantage 
services in this domain.

Note: If you move your Vantage domain database to another server, remove your 
license to deactivate it, and then import it and activate it again in the new database. 
Be sure to keep your license file (XML) as a backup.
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Installing Client Programs on Client Workstations
The available Vantage Client programs include the Vantage Management Console, the 
Vantage Workflow Designer, the Workflow Portal, and the Dublist Portal. These are 
installed on the Vantage server during initial installation, but they may also be installed 
on client workstations for use by administrators and workflow designers. 

To install the Vantage client programs on a workstation, do the following:

1. Log into the target workstation with a local administrator account, and make sure 
that virus-checking software and Windows Firewall is off.

2. Copy the Vantage 8.1 Client Applications.msi installer or the Vantage_8.1_Setup.exe 
installer to the workstation where you want to install the clients, or make the 
installer available on a network share. 

Note: Installers should not be mixed. Use the same installer for all subsequent client 
installation changes. Mixing installers may produce unexpected results. Also note that 
the Vantage Setup installer uses considerable storage for the zipped and unzipped 
files. If space is limited on your client workstations, use the Client Applications installer. 

3. Double-click the installer program to run it.

4. When the Welcome dialog appears, click Next to display the license agreement.

5. Read the Vantage Software License Terms and Conditions, click I Accept... if you 
agree to license terms, and click Next.

6. If using Vantage_8.1_Client_Applications.msi select which client apps to install.

7. If using Vantage_8.1_Setup.exe, select Single Node or Array Node installation and click Next.

8. If using Vantage_8.1_Setup.exe, select Custom Install, Client Applications, and click Next.

9. If using Vantage_8.1_Client_Applications.msi, select where to install and click Next.

10. When the Ready to Install dialog appears, click Install. 

11. When installation is done, click Finish to close the installer. 

Updating VOD DAI Workflow Portal Configurations
The VOD DAI Workflow Portal has been improved to provide new variables for Group 
Contiguous Ads and Enable Local Column Headers. Local Ad Descriptors have also 
been added, and available combinations of ad insertion types and descriptors have 
changed.

To make use of these new features, portal configurations created with versions prior to 
Vantage 7.2 must be recreated in Vantage 8.1. VOD Workflow Portal project files should 
also be recreated with Vantage 8.1 (if the Vantage 6.3 customer-only VOD DAI Local Ad 
Portal patch has not been applied) to make use of Local ad descriptors. 

If configurations and project files from prior to 7.2 are not recreated in Vantage 8.1, 
existing portal configurations and project files will continue to operate as before, but 
the new features will not be available. 
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Configuring Client DB Access and User Administration
The Vantage client and web applications connect to the Vantage database using the 
system administrator (sa) role by default. To provide greater security, you may want to 
create additional SQL roles for users that have a lower level of control. Additionally, you 
can restrict access to Vantage by enabling user administration and creating user 
accounts. 

The following procedures explain how to set up client database roles and Vantage user 
accounts.

Configuring Vantage DB Users
To create a new user for logging into the Vantage database from clients, follow these 
steps:

1. Launch the SQL Server Management Studio on the Vantage database server.

2. In Object Explorer, access Databases > Vantage >Security.

3. Right-click New and select User.

4. In the new user dialog box General page, select a user type and enter a login, 
password, and select other options. 

5. Click OK when finished.

The new user will appear in the Users list.

6. Expand Security, and expand Logins.

7. Right-click the new user and select Properties.
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8. In the Login Properties window, go to Server Roles and enable public. Click OK. 

The next step is to move to the client host and save the same user login and pass-
word for the client apps to use when logging into the Vantage database.

Configuring Client Login Connection Settings
To configure client apps to use the new client login to the database, follow these steps:

1. Open a client or web app and select (File >) Change Vantage Domain.

2. Click Search and select the Vantage domain from the list of domains.

3. Click the Connection Settings drop-down menu.

4. Enter the client database user and password in the Login and Password fields

5. Click OK.

6. Repeat these steps for each client application. 
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Enabling User Administration
The Vantage User Administration feature is disabled by default, so no login is required 
to use Vantage client apps. If you want to improve security by requiring a Vantage 
login, follow these steps:

1. Open the Vantage Management Console.

2. Select Settings and Options in the left panel.

3. Select the General tab.

4. Check Enable User Administration.

5. Check Use Windows Active Directory for Users if you want to use Windows logins 
for accessing Vantage. Leave this option unchecked to create unique Vantage user 
accounts for each user.

If Active Directory is enabled, ASP.NET Impersonation configuration is required, as 
documented earlier in this chapter under Using Web Apps with Active Directory.

See Managing Users in the Vantage Management Console Help system for more 
information.

Next, continue in the Vantage Management Console to create user accounts as 
explained in the next topic.
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Creating Vantage Users
If you enabled Vantage User Administration, create users as follows:

1. Click the New User button  or right-click and select New User.

2. For Windows Active Directory, search for and select a user. For a Vantage user 
account, enter the username and password (and confirm the password). 

3. Check the Administrator check box if you want the new user to be an administrator.

4. For non-administrators, check User cannot change password, if you want to protect 
the password from being changed by the user. 

5. Click OK or Add to add the user, and then click Save  to save your changes.

6. Repeat this process to create as many Vantage users as you need.

This completes the process of setting up clients and web apps for database and user 
access. Now when you start a client or web app, the client app will log into the Vantage 
database with the database user account you created with public privileges. Then the 
app will ask the user to log into Vantage with their Vantage or Windows Active 
Directory user account. This configuration provides a better level of security than the 
default settings. 
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Verifying the Installation
At this point in the installation, you should have a fully installed, fully functioning 
Vantage domain. Before installing updates or doing further system configuration, do a 
thorough check of all domain components to verify they are fully operational. 

Launch the following desktop shortcuts to make sure they are working:

• Vantage Management Console

• Vantage Workflow Designer

• Vantage Workflow Portal

• Vantage Dublist Portal

• Vantage Web Apps—use a browser to access this URL: 
http://[server name]/Vantage/

Testing the domain at this point assures you that everything has been installed 
correctly or allows you to pinpoint any components that need reinstalling or 
configuring. 

Once your system is known to work correctly, you can proceed to the next topic, 
installing updates. If any problems develop after updating, you will know that the 
update caused the problem, and you can focus on resolving the problem with the 
update.

Note: Existing workflows do not require updating to run as they did on the earlier 
Vantage release. However, new options in actions do not display automatically and are 
not usable until you upgrade each action as described in the Vantage User Guide.

Note: Automatic Windows and software updates and automatic restarts of Vantage 
servers should be disabled. Schedule update installation and system restarts only 
during planned maintenance periods to prevent disruption of Vantage operations. 
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Command Line Installation
Vantage includes the capability of installing from the command line, either attended 
(full UI) or unattended (silent, no UI). For example, system administrators may wish to 
install Vantage on multiple servers of an array by using an unattended command line 
installation mode that does not require you to answer any questions or manually select 
any options. Alternatively, you can initiate an attended full UI installation from the 
command line as well. 

Note: Unattended (silent) installation is intended for installing on array nodes that do 
not include the database or QuickTime, since the database and QuickTime cannot be 
installed using this mode. 

The Vantage 8.1 zip file consists of the Vantage Setup file along with other components, 
including ComponentPacs. When you unzip this file, it extracts the installation and 
supporting files to a directory of your choosing. 

The extracted directory contains a number of directories and files. These include:

• The ComponentPacs directory which contains multiple Vantage ComponentPacs.

• The redist directory which contains all of the non-Telestream redistributable instal-
lation packages, including 10 VC++ redistributables, .NET 4.8, openCL runtime, 
OpenXML SDK, UrlRewrite, and SQL 2019 Express.

• The tools directory which contains the Vantage Database Deployment utility.

• The Vantage_8.1_Setup.exe installer which is the main Vantage installation pro-
gram.
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Extracting and Running the Installer

1. See Vantage Installers Overview for details on obtaining and extracting from the zip 
file.

2. Open a command prompt.

3. Enter a command to run the installer Vantage_8.1_Setup.exe :
c:\> Vantage_8.1_Setup.exe -sp"/install /passive InstallFeatures=ClientFea-
tures"

4. Press Next to start the installation, and follow the prompts to complete the 
installation. Refer to Installing a Vantage Array earlier in this chapter for installation 
details.

The following topics present command line installation commands and options.

Vantage Setup Installer Commands
Commands, options, and parameters for the Vantage_8.1_Setup.exe installer are 
presented here. You can also see the list at the command prompt by using the help 
command. You can pass these commands through the archive executable so that 
extraction and installation run automatically, or you can extract the Setup installer and 
then issue these commands manually to control installation separately from extraction.

Help Command
To bring up the Vantage Setup command list after extraction, use this example help 
command:
C:\<Vantage_8.1_Setup.exe> /?
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Command Syntax
Commands follow this pattern:
<path><Vantage_Setup_Filename> /<Option> <Parameter=Value> <parameter=Value;Value>

The path to the executable file is first, followed by no space and the executable name. 
Next comes a space and a slash, followed by no space and an option. 
After the option come any parameters, separated by spaces. Multiple features (Values) 
for a single parameter are separated by a semicolon.

Command Examples
Example 1. Unattended installation of all Vantage services but no client apps:
C:\Vantage_8.1_Setup.exe /quiet InstallFeatures=FacilityFeatures

Example 2. Start attended full UI installation with customer service credentials:
C:\Vantage_8.1_Setup.exe /install ServiceAccount=MyDomain\DomainUser 
ServicePassword=passphrase

Replace the ServiceAccount and ServicePassword credentials above with the local or 
domain user account credentials that the services run under.

Example 3. Unattended installation of all services and clients:
C:\Vantage_8.1_Setup.exe /quiet InstallFeatures=VantageFeatures

Example 4. Unattended installation of clients only:
C:\Vantage_8.1_Setup.exe /quiet InstallFeatures=ClientFeatures

Example 5. Unattended installation of Web Applications:
C:\Vantage_8.1_Setup.exe /quiet InstallFeatures="Web Applications"

Note that quotation marks are required above and below because of the space 
between words.

Example 6: Unattended installation of clients and Web Apps:
C:\Vantage_8.1_Setup.exe /quiet InstallFeatures="Web Applications;ClientFeatures"

Command List
Specify the operation to be performed. If no command is specified, /install is assumed.

/install - Install Vantage

/uninstall - Remove Vantage

Options
When using the unattended installation modes, the Vantage Database and QuickTime 
will not be installed (as those components require user interaction). 

When using an unattended mode, the return code returned by the setup application 
should be checked to verify that the installation was successful.
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The installer uses standard Windows system error codes as its return values. For 
example, 0 indicates success; 3010 indicates that installation was successful, but a 
reboot is required.

/passive - Perform the operation with no user interaction. A progress dialog will be 
displayed.

/quiet - Perform the operation with no user interaction. To wait for the install process to 
be completed, the command can be run using start /wait.

/installDatabase - Perform an applicable SQL Server and Vantage Database installation. 
If a Vantage database already exists, this flag instructs the installer to update the 
existing database. Otherwise, a new database is installed and configured.

Parameters
Parameters are set using the form: ParameterName=Value with a space between each 
parameter/value pair.

InstallRoot - Specify a directory where the installation will be deployed.

DatabaseDir - Specify a directory where the database files will reside (only applies when 
the database is selected). This defaults to a subdirectory of InstallRoot.

StoreDir - Specify a directory where the default Storage will be created (only applies to 
single-node installs).

ServiceAccount - Specify the user account that each service should be configured to 
run as. This should be in the form domain\user.

ServicePassword - Specify the password for the ServiceAccount user.

InstallFeatures - A semi-colon delimited list of features to install. This list is tree-
structured, and specifying a parent feature will cause all child features to be installed. 
For example, including FacilityFeatures;ThirdPartyFeatures will cause all the Vantage 
services to be installed. See below for the available feature identifiers.

Features
This list is tree-structured, and specifying a parent feature will cause all child features to 
be installed. For example, if you want ALL features installed, only VantageFeatures 
needs to be specified.

VantageFeatures
ClientFeatures

WorkflowFeature
MmcFeature
DublistPortalFeature
SubmitApp

FacilityFeatures
AnalysisFacility
AvidFacility
CableFactoryFacility
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CatalogFacility
CloudFacility
FactoryFacility
HeFactoryFacility
MessageFacility
MetadataFacility
MonitorFacility
PlaylistFacility
PublisFacility
SdkFacility
StagingFacility
SubtitleFactoryFacility
TrafficFacility
TransportFacility

ThirdPartyFeatures
AlchemistFacility
AsperaFacility
AudioToolsFacility
CerifyFacility
BatonFacility
DigimetricsFacility
eMotionFacility
FileCatalystFacility
NexidiaFacility
PulsarFacility
ScreenFacility
SigniantFacility
VidCheckerFacility

WebApplications

Examples of Installing Vantage Services for a Local User
The following examples show how to install Vantage Services via the command line for 
a specific local user in a workgroup.

To install Vantage Services that use a specific local account:

1. Use the ServiceAccount and ServicePassword parameters in the command line.

2. Add the following to your command line:

ServiceAccount=hostname\User ServicePassword=Password

3. Edit the values <hostname> and <Password> as required for your installation.

See the following examples for specific commands using the steps above.

Example 1. Install Vantage clients, services, and files to the default locations without a 
database.

• Services will use the local administrator in this example to login.
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• Modify the ServiceAccount and ServicePassword values as required:

C:\Temp>Vantage_8.1_Setup.exe /install /quiet InstallFeatures=VantageFeatures 
ServiceAccount=hostname\administrator ServicePassword=admin

Example 2. Install Vantage services and files to the default locations without a Vantage 
database. Vantage client applications will not be installed.

• Services will use the local administrator in this example.

• Modify the ServiceAccount and ServicePassword values as required:

C:\Temp>Vantage_8.1_Setup.exe /install /quiet InstallFeatures=FacilityFeatures 
ServiceAccount=hostname\administrator ServicePassword=admin
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Example 3. Install Vantage services, Vantage files, and the Vantage database to the 
default locations. Vantage client applications will not be installed.

• Services will use the local administrator in this example.

• Modify the ServiceAccount and ServicePassword values as required:

C:\Temp>Vantage_8.1_Setup.exe /install /quiet /installdatabase InstallFea-
tures=FacilityFeatures ServiceAccount=hostname\administrator ServicePass-
word=admin

Example 4. Install Vantage services, Vantage files, the Vantage database, and Vantage 
client applications to the default locations.

• Services will use the local administrator in this example.

• Modify the ServiceAccount and ServicePassword values as required:

C:\Temp>Vantage_8.1_Setup.exe /install /quiet /installdatabase InstallFea-
tures=VantageFeatures ServiceAccount=hostname\administrator ServicePass-
word=admin

Example 5. Install Vantage services, Vantage files and the Vantage client applications to 
the default locations. The Vantage database will be installed to a location defined by 
DatabaseDir.

• Services will use the local administrator in this example.

• Modify the ServiceAccount and ServicePassword values as required:

C:\Temp>Vantage_8.1_Setup.exe /install /quiet /installdatabase Data-
baseDir=D:\SampleDatabaseDir InstallFeatures=VantageFeatures ServiceAc-
count=hostname\administrator ServicePassword=admin

Example 6. Install Vantage services and files to the default locations. The database will 
be installed to a location defined by DatabaseDir. Vantage client applications will not 
be installed in this example.

• Services will use the local administrator in this example.

• Modify the ServiceAccount and ServicePassword values as required:

C:\Temp>Vantage_8.1_Setup.exe /install /quiet /installdatabase Data-
baseDir=D:\SampleDatabaseDir InstallFeatures=FacilityFeatures ServiceAc-
count=hostname\administrator ServicePassword=admin
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Upgrading and Modifying 
Vantage

This chapter explains how to upgrade an existing Vantage installation from a prior 
version, how to update components, and how to modify an installation. These topics 
are discussed:

■ Upgrading from a Previous Version

■ To upgrade Vantage from any prior version, follow this procedure to uninstall all 
components except the domain database before installing the new version:

■ Installing the Upgrade

■ Updating Vantage Between New Versions

■ Using ComponentPac Management to Update Actions

■ Updating Individual Components

■ Moving the Vantage Domain Database

■ Adding a Server to a Vantage Domain

■ Adding a Lightspeed Server to an Existing Vantage Domain
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Upgrading from a Previous Version
If this is a new Vantage installation, skip this chapter and go to the Installing Vantage 
chapter. 

To upgrade Vantage from any prior version, follow this procedure to uninstall all 
components except the domain database before installing the new version:

1. Back up your Vantage database by using the Vantage Management Console 
Domain Management/Backup feature. You may also want to export all workflows, 
categories, nicknames, labels, variables, scripts, and other custom components.

2. Log into Vantage Workflow Designer Domain Job Status and stop all jobs or allow 
all jobs to complete.

3. Close all Vantage client programs and Web applications using this domain.

4. For each computer with Vantage client programs installed in this domain, log in 
with a local administrator account and perform the following steps:

a. Open Control Panel > Programs and Features > Uninstall Programs.
b. Select Vantage Client Applications (if present) and click Remove or Uninstall.
c. Uninstall all Vantage update packs that are installed: Select each Vantage update 

pack in reverse sequential order (latest to oldest), and click Remove or Uninstall. 
Perform this step for all installed update packs. 

5. On the server hosting Vantage Web apps, use the Control Panel uninstall tool (see 
Step 4) to select Vantage Web Applications and click Remove or Uninstall.

6. On the servers hosting the Telestream Media Transcode and Analysis engine, log in 
with a local administrator account and follow these steps:

a. Select Start > Administrative Tools > Services to display the Services window.
b. Right-click and select Stop for the following services: Vantage Analysis service 

and the Vantage Transcode service.
c. In the Control Panel uninstall tool (see Step 4), select Telestream Media 

Transcoding & Analysis Engine and click Remove or Uninstall.

7. On the Vantage database server log in with a local administrator account, and using 
the Control Panel uninstall tool (see Step 4), follow these steps:

Note: Subsystems (IPP, QuickTime, etc.) that have been installed during Vantage 
installation are not removed, and Vantage domain data and media you have created 
are not removed.

a. Select Vantage and click Remove or Uninstall. This removes Vantage, but your 
Telestream folder, including your Database folder and files, remain in place so 
your Vantage configuration is preserved.

b. Leave MS SQL Server in place—do not uninstall it.
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Note: If you want to change the Microsoft SQL edition (for example, from Express to 
Standard), or if you want to move the Vantage domain database to a different server, 
complete the Vantage installation, and then see Moving the Vantage Domain Database. 

At this stage, the Vantage software has been removed, but your database contents and 
service configuration files and the SQL Server are still intact. When you install the latest 
Vantage, you can reuse these database files and let Vantage upgrade them. Continue 
now with the next topic, Installing the Upgrade.

Installing the Upgrade
The following procedure upgrades an older Vantage version to a new one. 

CAUTION: Upgrade all components. Upgrading only selected components can result 
in component mismatches, causing a non-functioning Vantage system. If you have 
any questions, contact Telestream Vantage Support.

1. Log in to the Vantage server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall are off. (See Anti-Virus Software 
Recommendations and Firewall Guidelines for details))

2. To protect your data, use the Vantage Management Console to back up your 
database using the Domain Management/Backup feature to create a backup file. 
(See Backing up the Existing Database for instructions.)

3. Stop any active jobs or allow them to complete. Workflows should be deactivated. 
Close any open Vantage apps.

4. Run the Vantage_8.1_Setup installer. See Vantage Installers Overview for details. 

5. When the Welcome dialog appears, click Next to display the license agreement. 

6. License Agreement—Click I Accept if you agree to the license terms, and then click 
Next.

7. Select Custom Install and select check boxes to install the desired Vantage features, 
and click Next. 

8. When Ready to Install appears, click Install to begin installation, which takes a few 
minutes. Progress is displayed as the installation takes place.

Note: The Vantage Setup program checks for an existing SQL Server installation, and 
if found, Setup skips the installation of SQL Server. If SQL Server is not found, SQL 
Server 2019 Express will be installed. Similarly, if no Vantage database is found, a new 
one is installed. If a Vantage database is found, it is upgraded; upgrading preserves 
workflows, design items, job history, catalogs, stores, application configurations, user 
settings and licenses.

9. Click Next when the installer indicates it is finished. 

10. When installation is complete, click Finish to quit. 
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11. The installer displays Installation was successful! (or indicates errors if unsuccessful). 
Click Done to close the installer application. Database installation is complete.

12. If you are upgrading a Vantage Array, you have just completed the database server 
upgrade. Next, upgrade any other servers in the next step.

13. Repeat these steps for any other servers in the Array, such as servers hosting the 
transcoding engine, services, and web applications. When you run the installer on 
each server, select the components to install corresponding to the components 
you are replacing on that server.

14. When all servers and components have been upgraded, the upgrade is complete.

15.  Test your workflows to make sure all required items to run the workflows are still 
present and the workflows still run as expected.

Note: Existing workflows do not require updating to run as they did on earlier 
Vantage releases. However, you might need to re-create some aspects of existing 
workflows to take advantage of new user interface components. For example, new 
options in Flip actions do not display automatically after upgrading. Refer to the 
Vantage User Guide for details about enabling new features in actions and workflows.

Note: If your ComponentPacs from an earlier Vantage version (for example Vantage 
8.0) reside in a custom location other than C:\Program Files 
(x86)\Telestream\Vantage\ComponentPacs, you will need to copy the 
ComponentPacs installed with Vantage 8.1 from C:\Program Files 
(x86)\Telestream\Vantage\ComponentPacs to your custom location. You will then need 
to use the ComponentPac Management feature in the Vantage Management Console 
to install the ComponentPacs that came with Vantage 8.1.

You can see or change the location in which ComponentPacs reside using 
ComponentPac Management > ComponentPac storage location in the Vantage 
Management Console. 
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Updating Vantage Between New Versions
Between version upgrades, Telestream may issue update packs for the current Vantage 
version to replace selected components for the purpose of adding small features, bug 
fixes or improving performance. The Update Pack installers are designed to install 
smoothly with minimal impact to the overall installation. 

To locate and install Vantage update packs, do the following:

1. Go to the Telestream Vantage download Web site:

http://dynamic.telestream.net/downloads/download-vantage.asp?prodid=van-
tage

2. Review the Vantage download page to determine if there are any update packs 
that should be installed.

3. If there is an update pack to install, review the release notes that accompany the 
update and install the update pack according to your requirements and the 
instructions in the Release Notes.

Note: Unlike Component Pacs, currently installed update packs are not readily 
discernible from with the Vantage Management Console. To determine which update 
packs you already have installed, open System Settings and review Programs and 
Features.
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Using ComponentPac Management to Update 
Actions

ComponentPacs are uniquely numbered and versioned software libraries that have 
replaced the component patches previously distributed for updating these specific 
transcoding-related actions: 

Analyze
Avid Asset Monitor
Avid Media Creation
Avid Media Management
Capture
Chronicle
Compose
Conform
Flip 64
IPTV Flip
Multiscreen Flip
Multiscreen DRM
Tape Capture
Tempo
Timed Text Flip
Timed Text Conform

These libraries install into an existing Vantage Framework using the ComponentPac 
Management feature of the Vantage Management Console (below). They must be 
stored in a central location accessible to all machines in a Vantage Array.

Please note that if a change is required within the Vantage framework to non-
transcoder service components, those updates are still made using a Vantage patch or 
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update pack, not a ComponentPac. Note also that the Flip, Identify, and Examine 
actions are not managed by the ComponentPac feature.

Installing ComponentPacs
Installing new ComponentPacs as explained below makes them available for use but 
does not affect existing jobs, actions, or workflows until you explicitly upgrade them. 

1. Obtain the new ComponentPac from Telestream.net or Telestream Support and 
place it in a folder accessible by the Vantage Management Console.

2. Open the Vantage Management Console, and click ComponentPac Management in 
the left column. Installed ComponentPacs, if any, are listed in the Installed 
ComponentPacs list on the right. 

3. In the right panel Storage Location field, enter or browse to specify a path to a 
central ComponentPac storage location. This is where new downloaded packages 
will be stored and installed from. If you do not specify a path, the default location is 
used: C:\Program Files (x86)\Telestream\Vantage\ComponentPacs\.

Note: For an all-in-one (single node) installation, the ComponentPac storage location 
can be a local path. For a multi-node installation (Vantage array), the ComponentPac 
storage location must be accessible to the Vantage services on all Vantage servers (via a 
UNC path or a SAN drive letter with appropriate permissions). 

One convenient way to securely install ComponentPacs from a share is to use Vantage 
Authorization credentials. To do this, create a share for a single user which is a different 
login than the logins to Windows or Vantage. (Shares can be created for single or 
multiple users or groups, and the user can be the same or different from the Windows 
user login.) Then in the Vantage Management Console, go to Settings & Options > 
Authorization and add the credentials for the share user. Next, restart the services to 
recognize the new credentials, and then test share access. You can now use the share as 
your ComponentPac central storage location.
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4. Click the Install new package button.
5. Browse to where you downloaded the ComponentPac. Click on the ComponentPac 

to install, and click Open. (Skip if the ComponentPac is already present.)

6. Check the desired ComponentPac in the Install ComponentPacs window, and click 
Install to install and register the package with the domain.

7. When installation finishes and the package appears in the Installed ComponentPacs 
list, restart all affected services on all nodes to deploy the pacs. ComponentPacs are 
unpacked and made ready for use when the Vantage services targeted by the 
ComponentPac are restarted. Unpacked pacs are stored in C:\Program Files 
(x86)\Telestream\Vantage\Components\ on each Vantage service node.

Notes:
1. New actions and workflows created in the Workflow Designer use the latest 

installed ComponentPac. However, existing actions and workflows must be 
selected and upgraded to use the latest ComponentPac. If they are not upgraded, 
they will continue to use the ComponentPac with which they were created. See the 
Vantage User Guide for detailed action and workflow upgrade instructions.

2. In Vantage version 7.0, existing actions and workflows use the latest installed 
ComponentPac if the ComponentPac used to create them is no longer present. You 
may need to recreate the action if the latest ComponentPac does not support the 
action's outdated settings. If the missing ComponentPac is reinstalled, the actions 
will resume use of that ComponentPac.

3. Starting with Vantage 7.0 Update Pack 1, workflows created with a previous version 
of Vantage (such as Vantage 6.3) use the earliest ComponentPac installed. When 
you upgrade a workflow created with an older Vantage version to Vantage 7.0 or 
later, the actions are tied to the latest ComponentPacs currently installed.

4. The Session Log available in the Workflow Designer Job Status or Domain Job 
Status panel lists which ComponentPac was used for a completed job. 

5. If a Vantage service is unable to unpack a ComponentPac (such as when the 
Vantage service does not have the appropriate user credentials to access the file 
location of where the ComponentPac file resides), an entry is added to the service 
trace log to record the issue.

6. If you convert a single-node Vantage domain to a multi-node Vantage domain and 
if the installed ComponentPacs reside in a local path, the ComponentPacs must be 
copied or moved to a shared folder location and re-installed or re-registered.
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7. If you have deployed a new database or replaced an existing database with a new one 
using the Database Deployment Utility, the domain will not have any ComponentPacs 
installed. When you run the Vantage Setup installer to install Vantage components 
and services after deploying the database, the major ComponentPacs will be installed. 
If you do not run the Vantage Setup installer after database deployment on the 
database server, or if you wish to install additional ComponentPacs, use the Vantage 
Management Console > ComponentPac Management feature to install the 
ComponentPacs as described in the preceding steps.

8. Upgrading Vantage via an update pack, such as 7.0 UP1, may cause ComponentPac 
actions to be shown as eligible for upgrade even though a new ComponentPac has 
not been installed. This is normal behavior for update packs. You can upgrade the 
ComponentPac actions or not, as you prefer.

9. Attempting to install a future ComponentPac that doesn't match the current 
Vantage version fails to install the ComponentPac and displays an error message: 
“ComponentPacs built for a future release of Vantage are not supported, and will 
not be installed.”
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Upgrading Actions and Workflows
When upgraded, existing actions and workflows can use the latest installed 
ComponentPacs, framework upgrades, or component patches. These instructions briefly 
explain how to upgrade existing actions and workflows. See the Vantage User Guide for 
detailed action and workflow upgrade instructions. 

Note: Once an action is upgraded it can't be directly downgraded. However, you can 
restore workflows to their pre-upgraded state by importing the automatic backup 
copy that Vantage places in the C:\VantageWorkflowBackup directory (local to the 
Workflow Designer client). Beginning with Vantage 7.0 UP1, a log file describing the 
upgrades is also included in that directory. 

Note: If you want to change the location of automatic ComponentPac backups, open 
the Vantage Management Console, select Settings and Options, and browse for a new 
Location for workflow backups. 

Note: During service startup, if multiple ComponentPacs are available, the service 
uses the highest-versioned ComponentPac to populate the action template in the 
database. This process updates default action configurations and also ensures that 
newly created actions will always use the latest ComponentPac. 

Upgrading an Action
To upgrade an action in Workflow Designer, right-click the action in its workflow and 
select Upgrade from the context menu.
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Upgrading a Workflow
To upgrade a workflow in Workflow Designer, right-click the workflow in the workflow 
list on the left, and select Upgrade from the context menu.

Upgrading Workflow Batches
To upgrade workflows in batches or all at once, click the Batch Workflow Operations 
button in the upper left corner of the Workflows list, or select File > Batch Workflow 
Operations > Check for Upgrades.

Locking Against Upgrades
You can also lock workflows to protect against upgrades until you are ready, providing 
Secured Version Control. To do so in the Vantage Workflow Designer right-click the 
workflow in the workflow list and select Lock. You can also select Lock for multiple 
workflows using the Batch Workflow Operations dialog.



Upgrading and Modifying Vantage
Using ComponentPac Management to Update Actions

132

Removing ComponentPacs
To remove old ComponentPacs:

1. Open the Vantage Management Console, and click ComponentPac Management in 
the left column. Installed ComponentPacs are listed in the Installed 
ComponentPacs list on the right. 

2. Click the package you plan to uninstall and check the Actions panel for affected 
workflows and actions.

Export all workflows that reference the ComponentPac you want to uninstall (to 
back them up), and then delete the workflows in Vantage.

3. Click the Uninstall button in the ComponentPac Management window while the 
package to be removed is selected. 

Note: The Uninstall button appears only when a package is not used by any actions. 

4. After uninstallation completes, restart the affected Vantage services. If the 
Workflow Designer was open, close it and reopen so all the changes to take effect.

The selected old package is removed and no longer appears in the ComponentPac 
Management list.
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Updating Individual Components
At times, you may be instructed by Telestream Support to update specific components 
that are not handled by the ComponentPac feature. 

CAUTION: Updating individual components should be done only as recommended 
by Telestream. Upgrading only selected components can result in component 
mismatches, causing a non-functioning Vantage system. If you have any questions, 
contact Telestream Vantage Support before updating.

The Vantage_8.1_Setup.exe installer allows you to add (or re-install) individual Vantage 
components (services, clients, T&A Engine) as your needs change. You can rerun the 
installer, select Modify at the first screen, and check the components you want to add. 

The following instructions explain how to install individual components:

• Updating the Vantage Domain Database

• Updating Vantage Server Components

• Updating Vantage Clients on Client Workstations

• Updating Vantage Web Applications

• Moving the Vantage Domain Database
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Updating the Vantage Domain Database
The following procedure guides you in updating your Vantage database without 
removing or changing your SQL Server version.    

To update the Vantage domain database, follow these steps:

1. Log in to the target server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall are off.

Note: For additional information on Vantage use with anti-virus software, see Anti-
Virus Software Recommendations. For more information on Vantage use with the 
Windows Firewall, see Firewall Guidelines.

2. To protect your data, open the Vantage Management Console and back up your 
database using the Domain Management/Backup feature to create a backup file. 
See Backing up the Existing Database if you need detailed instructions.

3. Run the Vantage-8.1-Database-Deployment-Utility.exe installer. 

4. When the Welcome dialog appears, click Next to display the license agreement. 
Click I Accept if you agree to the license terms, and then click Next.

5. Select Upgrade when the Database install mode dialog appears, and click Next.

This instructs the Vantage installer to upgrade your database and preserve informa-
tion for workflows, design items, job history, catalogs, stores, application configura-
tions, user settings and licenses.

6. When the Destination Folder dialog appears, accept the default folder or click 
Change to select an alternate directory on another drive; then click Next.

7. When the Ready to Install Vantage Domain Database dialog appears, click Install to 
begin database installation. This process takes a few minutes to complete.

The Vantage installer upgrades your database and preserves information for work-
flows, design items, job history, catalogs, stores, application configurations, user 
settings and licenses.

Note: Existing workflows do not require updating to run as they did on earlier 
Vantage releases. However, you might need to re-create some aspects of existing 
workflows to take advantage of new user interface components. For example, new 
options in Flip actions do not display automatically after upgrading. Refer to the 
Vantage User Guide for details about enabling new features in actions and workflows.

8. When installation is complete, click Finish to quit.
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Updating Vantage Server Components
The following procedure updates or modifies the existing Vantage installation to add or 
remove components. If you are upgrading from one version of Vantage to another, do 
not use this procedure; instead see Upgrading from a Previous Version.

Note: If you plan to update Vantage and Vantage Web Applications on the same 
server, you can avoid a Vantage service restart by first updating Vantage Web 
Applications. See Updating Vantage Web Applications. After installing the Web Apps, 
return here and continue this procedure.

1. Log in to the target server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall are off.

Note: Telestream recommends not using anti-virus software on Vantage servers. If 
you use anti-virus software, you should identify Vantage as a safe/trusted application. 
See Anti-Virus Software Recommendations and Firewall Guidelines.

2. Run the Vantage_8.1_Setup.exe installer. 

3. Select Modify which products and features are installed. (This option is presented 
only if you use the installer originally used to install Vantage, which you should be 
careful to do. You should not use a newer installer unless instructed by Telestream.)

4. Select Custom Install. 

5. Check the boxes for all Vantage components on this server that you want to install, 
and uncheck any you want to remove, and click Next. 

6. When the Ready to Install dialog appears, click Install to begin installation. This 
process takes a few minutes and shows progress as it runs.

If Intel Performance Primitives (IPP) is not present, it is installed. For existing installa-
tions, it should already be present.

If QuickTime is not installed (it should be), the installer installs it for you. If you need 
to install it manually, use this link to download it: QuickTime version 7.6.9. 

7. When installation is complete, click Finish to close the installer.

Note: For an All-in-One Single Node installation, Vantage creates a temporary storage 
area on the local hard drive, and creates a default Vantage catalog in the database.

8. Open the Vantage Management Console, select Services in the left panel, and verify 
that the services you installed are Online and those you removed are Offline. 

9. If you changed the clients, verify that the icons on the desktop changed 
accordingly.

http://appldnld.apple.com/QuickTime/041-0025.20101207.Ptrqt/QuickTimeInstaller.exe
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Updating Vantage Clients on Client Workstations
The following procedure explains how to update Vantage clients installed on client 
machines. To update clients on Vantage Servers, see Updating Vantage Server 
Components. These client programs can be updated:

• Vantage Management Console (VMC)
• Vantage Workflow Designer
• Vantage Dublist Portal
• Vantage Workflow Portal

You can use either the Vantage 8.1 Client Applications.msi installer or the 
Vantage_8.1_Setup.exe installer to update clients on client machines. When installing on 
client machines, the client installer is recommended because it downloads faster and 
takes up less space during installation than the Vantage installer. 

Note: Do not mix installers. Whether you use the Vantage installer or the client installer 
to install the clients, use the same installer for all subsequent client installation changes 
on that machine. Mixing installers may produce unexpected results.

Using the Client Installer to Install or Update Clients
Install or update Vantage clients using the Vantage 8.1 Client Applications.msi installer:

1. Use Windows Control Panel Programs and Features to uninstall existing clients.

2. Run the Vantage 8.1 Client Applications.msi installer as an administrator.

3. Accept the license, and select the installation location.

4. Check the clients you want to install and uncheck those you want to remove. 

5. Follow the installer steps to complete the installation. 

Note: If you simply want to add or remove existing applications, the client installer 
allows you to Change, Repair, or Remove. These options are presented if you leave the 
applications in place before running the installer. If you choose Change, applications 
you check will be installed, and applications you uncheck will be removed.

Using the Vantage Installer to Install or Update Clients
Install or update Vantage clients as follows using the Vantage_8.1_Setup.exe installer:

1. Use Windows Control Panel Programs and Features to uninstall existing clients.
2. Run the Vantage 8.1.Setup.exe installer as an administrator.
3. Select Single Node Install.
4. Select Custom Install.
5. Check the clients you want to install and uncheck those you want to remove.
6. Browse to select where to install the clients. 
7. Follow the installer steps to complete the installation. 
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Updating Vantage Web Applications
Vantage Web Applications may be installed as part of a Vantage Array and may be 
updated separately or as part of an array upgrade.

Note: If you are updating the Vantage Web Applications on a server that also hosts 
Vantage services, the Vantage Web Applications upgrade will stop those services, 
which will interrupt Vantage operation. Plan to upgrade the Vantage Web 
Applications when the upgrade will cause the least interruption to Vantage users. This 
is not an issue when the Vantage Web Applications are installed on a dedicated server.

If you are updating the Vantage Web Applications from version 3.0 or later to 8.1, you 
do not need to repeat the IIS and .NET server preparation described for new 
installations. To update Vantage Web Applications, do the following:

1. Uninstall the Web Apps using the Windows Programs and Features Control Panel.

2. Download and run one of these installers as an administrator: 

– Vantage main installer: Vantage_8.1_Setup.exe.

– Vantage Web Applications installer VantageWebApplicationsSetup.exe

To run the EXE as an administrator, right-click and choose “Run as Administrator”.

Note: The Vantage_8.1_Setup.exe will remove the Web apps if you run it after installing 
them. Finish installing all Vantage components on the server before you install the Web 
Apps.

3. When the Welcome Window appears, click Next.

4. Read the license agreement, and if you accept the terms, click I Agree, and Next.

5. If using the Vantage_8.1_Setup.exe installer, select Array Installation, select Custom 
Install, scroll the list, and select Web Applications.

6. When the Select Installation Address dialog appears, set the Application Pool 
selection to .NET 4.5 for Server 2012, and click Next.

7. Click Install to start the installation.

8. When the Installation Complete dialog appears, click Finish.

9. If Vantage services were running before the Vantage Web Applications upgrade, 
restart those services using Vantage Management Console > Services or the 
Microsoft Services tool (Start > Administrative Tools > Services).

Note: If you experience any problems with the upgrade, refer to Troubleshooting 
Vantage Installation. For information on the browser requirements for Vantage Web 
Applications, see Vantage Web Applications Browser Requirements in Before You Install 
Vantage.
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Moving the Vantage Domain Database
You might want to move the Vantage domain database because:

• You are upgrading SQL Server from Express to Standard

• You are upgrading SQL Server from an older version to a newer one

• You are moving the database from one server to another

Note: If you are moving the database in conjunction with a Vantage upgrade, you 
should complete the upgrade prior to moving the database.

Note: This guide does not provide instructions for moving a mirrored database. 
Consult your database administrator or contact your Telestream representative 
regarding installation service options.

To move a Vantage domain database, follow the procedures in the following topics in 
the sequence presented:

1. Preparing for the Move

2. Backing up the Existing Database

3. Removing the Vantage Domain Database

4. Removing Microsoft SQL Server

5. Installing SQL Server Standard

6. Installing the Vantage Domain Database

7. Restoring the Vantage Domain Database Backup

8. Finishing the Move

Note: This procedure backs up the database, moves the database to a different 
SQL Server version and/or server, and restores the database. Vantage does not 
support a Vantage restore from a version 3 Vantage database to a version 4 domain.
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Preparing for the Move
If you are upgrading SQL Server, it is recommended that you back up the Vantage 
domain database, but it is not required. However, if you are moving the Vantage 
domain database to a new server, you must backup the database, as the backup file will 
be used to restore the domain on the new server.

To back up the existing Vantage domain database so that it can be transferred to the 
new database later, follow these steps:

1. Use Vantage Workflow Designer to deactivate all active workflows to prevent new 
jobs from starting.

2. Use the Job Status Views tab in Vantage Workflow Designer, the Vantage Job Status 
Views web application, or Vantage Dashboard to either determine when all jobs are 
complete or stop any jobs in process or in waiting.

3. If you are moving the database to another server, do the following:

a. Take note of any Storage, Variables, and/or Qualification Rules settings for each 
service. (In the Vantage Management Console, select Services. In the service 
panel, click each service and check the tabs at the bottom of the window.)

When you move the Vantage domain database from one server to another, the 
Storage, Variable, and Qualification rule configuration for each service is lost. 
Write down any configuration that you want to transfer to the new server.

Note: The service Storage, Variable, and Qualification Rule configuration is not lost 
when you change the SQL Server version on a server. Skip to Step 4 if you are not 
moving the Vantage domain database to a different server.

b. In the Vantage Management Console, remove all services from the Vantage 
domain (refer to Managing Services in the Domain Management Guide for details).

Note: The default Vantage user account is Administrator with no password. This 
account has administrative privileges.

c. In the Vantage Management Console, select Licenses in the components panel.
d. On the Licenses tab, select all licenses and click the Delete button .

Note: To add the licenses back a the end of this procedure, you will need access to the 
license files. If you do not know where these files are, locate them now before you 
delete them from the existing database.

4. If you are changing the Microsoft SQL version on a server (and not moving the 
database to another server), place all services in Maintenance Mode (refer to 
Managing Services in the Domain Management Guide for details).
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Backing up the Existing Database
If you are upgrading SQL Server, it is recommended that you back up the Vantage 
domain database. If you are moving the Vantage domain database to a new server, you 
must backup the database, as the backup file will be used to restore the domain on the 
new server.

To back up the existing Vantage domain database so that it can be transferred to the 
new database later, follow these steps:

1. In the Vantage Management Console, select the domain you want to modify, select 
Domain Management in the components panel, click Backup, and use the file save 
dialog to save the backup file to a safe location.

You will need to access the backup file to restore the Vantage domain database 
after you move it. 

2. Close all Vantage clients, including Vantage Workflow Designer, Vantage Web 
Applications, Vantage Workflow Portal, and Vantage Management Console.

Removing the Vantage Domain Database
The Vantage Domain Database may or may not be present as a separate entry in the 
Windows Control Panel Programs and Features window, depending on how it was 
originally installed. 

In either case, the Domain Database must be removed using one of the following 
procedures:

If the Domain Database is present in the Control Panel list, remove it as follows:

1. Log in to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

Control Panel > Programs and Features > Uninstall Programs.

3. Select Vantage Domain Database and click Remove or Uninstall.

If the Domain Database is not present in the Control Panel list, remove it as follows:

1. Log into the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

Control Panel > Programs and Features > Uninstall Programs.

3. Select Vantage and click Change.

4. Deselect the check box for Vantage Domain Database and continue with removal.
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Removing Microsoft SQL Server
When you are upgrading Microsoft SQL Server or moving the Vantage domain 
database to another server, you may want to remove the old version of SQL Server. 

To remove Microsoft SQL Server, follow these steps:

1. Log in to the server with a local administrator account.

2. Open the control panel tool for removing programs:
Control Panel > Programs and Features > Uninstall Programs.

3. Select Microsoft SQL Server and click Remove or Uninstall.

Note: If you are prompted to stop the SQL Server (VANTAGE) service, go to Start > 
Services and stop the service before clicking Retry to continue with uninstalling.

Note: If you have multiple instances (for example SQLEXPRESS and VANTAGE), you 
will need to remove them both.

4. Select Microsoft SQL Server Native Client and click Remove or Uninstall.

Note: Uninstalling the SQL Server does not delete your Vantage workflows, resources, 
or transaction history. It leaves your domain database files intact in 
[Install_Drive]:\Program Files\Telestream\Vantage\Database. For information on 
removing the database files, see Uninstalling Vantage from a Server in the Removing 
Vantage chapter of the Domain Management Guide.

At this point, the SQL Server is removed but the database files and any Vantage services 
and clients that were installed on the server remain installed. The domain cannot 
resume operation until the SQL Server is reinstalled on this server or set up on another 
server.
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Installing SQL Server Standard
Please see Installing SQL Server Standard in the Vantage Installation Guide or the Vantage 
Domain Management Guide. After installing SQL, continue with the next topic below.

Installing the Vantage Domain Database
This task installs the Vantage domain database instance. Follow these steps:

1. Log in to the database server with a local administrator account, and make sure 
that virus-checking software and Windows Firewall is off.

Note: To effectively operate Vantage services with other networked devices or 
systems, you must turn off Windows Firewall.

2. Stop the SQL Server Agent Service in Start > Services, if it is running. 

3. From the tools folder (created when you extracted the files as described in Vantage 
Installers Overview) run the Vantage-8.1-Database-Deployment-Utility.exe installer.

4. When the Vantage Database Deployment Utility dialog appears the license 
agreement is displayed. Click I Accept if you agree to the license terms, and then 
click Next.

5. Select the Host, Instance, and Authentication Mode to use. Click Connect.

Note: Consult the Database Deployment Utility application note available on the 
Telestream website for more details.

6. Follow the prompts to install a new Vantage Domain Database.

If you are upgrading SQL Server on the same server, the upgrade is almost complete. 
Vantage should have discovered the old database files. Now you need to finish the 
process as described in Finishing the Move. 

If the old database files are not found, or if you are installing the Vantage domain 
database on a different server, restore the database from the backup file as described in 
Restoring the Vantage Domain Database Backup.
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Restoring the Vantage Domain Database Backup
To restore the Vantage domain database using the backup file you previously created, 
follow these steps:

1. Start the Vantage Management Console on any Vantage server in the domain.

Note: If you have moved the Vantage domain database to a new server, the name of 
the Vantage domain changed to the name of the new host server. 

2. In the Vantage Management Console, select the domain to modify (File > Change 
Vantage Domain), select Domain Management in the left components panel, click 
Restore..., and select the file to restore. For more information, refer to the Database 
chapter of the Domain Management Guide.

Finishing the Move
To finish the move, you must enable the services you disabled when preparing for the 
move. If you moved the Vantage domain database to another server, you must also 
install Vantage licenses. To return Vantage to operation, follow these steps:

1. If you changed the Microsoft SQL version on a server (and did not move the 
database to another server), do the following:

a. Remove all services from Maintenance Mode. (In the Management Console, 
select Services in the left panel, Ctrl-click to select all services in the right panel, 
right-click to select Exit Maintenance Mode, and click OK.)

b. Skip to Step 4.

2. If you moved the Vantage domain database to a different server, activate Vantage 
Domain licenses as follows:

a. In the Vantage Management Console, open the domain you want to modify, and 
select Licenses in the components panel.

b. On the Licenses tab, click the Add License button  and use the open file dialog 
to select the license file.

If your domain has multiple license files (for multiple features), repeat this step 
for additional licenses.

3. If you moved the database to another server, update the configuration of services 
as follows:

a. In the Vantage Management Console, open the domain you want to modify, and 
select Services in the components panel.

b. In the Services panel, click the Add Service button  and use the dialog to select 
a service to add.

c. If any Storage, Variables, and/or Qualification Rules settings were configured for 
the service, add them now.

d. Repeat this step for each service until all services are updated.

4. Use Vantage Workflow Designer to reactivate all workflows.
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Adding a Server to a Vantage Domain
The table below lists the types of servers you might want to add to a Vantage domain 
and shows where you can find instructions for adding these servers.

Server Type Instructions

Vantage Lightspeed 
server

A Vantage Lightspeed server can be added to a Vantage domain that uses 
Vantage version 4.0 or later. When you add a Vantage Lightspeed server 
to a Vantage domain, the Lightspeed server must be running the same 
Vantage version as the Vantage domain.

The Vantage Lightspeed server ships with an installed Vantage domain 
database, and all Vantage services on the Lightspeed server are assigned 
to that Vantage domain database. To add the Vantage services on the 
Lightspeed server to the existing domain, use the Vantage Management 
Console to reassign the services.

After you reassign the Vantage services, Telestream recommends that you 
remove the Vantage domain database on the Lightspeed server so that 
the old Vantage domain is no longer advertised to Vantage client 
programs and Web applications.

To remove the Vantage domain database from the Lightspeed server and 
reassign services, see Adding a Lightspeed Server to an Existing Vantage 
Domain.

Vantage domain 
database server

A Vantage domain can host one Vantage domain database, which can be 
installed on a single or mirrored database server. 

If your Vantage domain has a Vantage domain database on a single 
database server, you can do the following:

• Move the Vantage domain database to another server as described in 
Moving the Vantage Domain Database.

• Add a database server to mirror the current server. 

This guide does not provide instructions on setting up a mirrored 
database server. Consult your database administrator or contact your 
Telestream representative regarding installation service options.

Vantage array server Additional Vantage array servers add more throughput capacity to your 
Vantage domain. When you add a Vantage array server to a Vantage 
domain, the server must be running the same Vantage version as the 
Vantage domain. For instructions on adding a Vantage array server, see 
Installing Vantage Array Components in the Domain Management Guide.
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Adding a Lightspeed Server to an Existing Vantage 
Domain

This topic describes how to add a Lightspeed server to an existing Vantage domain. A 
Vantage domain can host just one Vantage domain database. When you add a 
Lightspeed server to an existing domain, Telestream recommends that you remove the 
Vantage domain database and SQL Server on the Lightspeed server so that Vantage 
does not advertise the unused Vantage domain on the Lightspeed server, and so that 
memory used by the SQL Server becomes available for Vantage use.

Note: The Lightspeed server and the existing Vantage domain must be using the 
same Vantage release, which must be Vantage 4.0 or later.

To add a Lightspeed server to an existing Vantage domain, follow the procedures in the 
following topics in the sequence presented:

1. Moving Licenses to Another Domain

2. Moving Vantage Services to Another Domain

3. Setting the Vantage Windows Log On ID for a Service

4. Removing the Vantage Domain Database

5. Removing Microsoft SQL Server

Vantage Web 
Applications server

For instructions on adding a Vantage Web Applications server, see 
Installing and Configuring Vantage Web Applications in the Domain 
Management Guide.

Vantage store You can add multiple Vantage stores to a domain. A Vantage store can 
reside on a dedicated server or with Vantage services. For instructions on 
setting up a Vantage store, see Setting Up a Vantage Store in the Domain 
Management Guide.

Server Type Instructions
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Moving Licenses to Another Domain
Any purchased licenses that have been added to the Lightspeed server should be 
removed from the Lightspeed server so they can be added to the existing domain. 
Most Vantage domains have a single license that contains multiple license options. 
However, Vantage can accept and combine license options in multiple license files. In 
most cases, you need to remove the license from the Lightspeed server and contact 
Telestream to arrange a Lightspeed server update to the license for the existing 
domain.

To delete licenses from the Lightspeed server and add them to the existing Vantage 
domain, do the following:

1. In the Vantage Management Console, open the domain for the Lightspeed server, 
and select Licenses in the components panel.

Note: The default Vantage user account is Administrator with no password. This 
account has administrative privileges.

2. Place all services in Maintenance Mode. (In the Management Console, select 
Services in the left panel, Ctrl-click to select all services in the right panel, right-click 
to select Enter Maintenance Mode, and click OK.)

3. On the Licenses tab, select all licenses and click the Delete button .

Note: To add licenses to the other domain, you will need access to any license files 
sent from Telestream or an updated license file for the other domain.

4. In the Vantage Management Console, open the domain to which you want to add 
the licenses, and select Licenses in the components panel.

5. If you are updating the license for the existing domain, do the following:

a. Select the license you are updating and click the Delete button .
b. Click the Add License button  and use the open file dialog to select the 

updated license file.

6. If you are adding licenses to the existing domain, click the Add License button  
and use the open file dialog to select a license file.

Repeat this step for additional licenses.

7. Take all services out of Maintenance Mode. (In the Management Console, select 
Services in the left panel, Ctrl-click to select all services in the right panel, right-click 
to select Exit Maintenance Mode, and click OK.)
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Moving Vantage Services to Another Domain
To move services from the Lightspeed server domain to the existing Vantage domain, 
do the following:

1. In the Vantage Management Console, open the existing domain to which you want 
to add the Lightspeed server services.

2. Select Services in the component (left) panel.

3. Click the Add Service button  to display the Select Service dialog. 

The Select Service dialog lists all Vantage services running in this subnet, and the 
list includes unassigned services and services running on other Vantage domains.

4. Select one or more Lightspeed server services to add to this domain, and click OK 
to add them.

Services are identified by name, machine, and Vantage domain. Use the machine 
name to identify the services on the Lightspeed server. To select multiple services, 
use shift-click to select a series of services, or use option-click to select individual 
services.

5. If you are moving a service from one domain to another, the Vantage Management 
Console displays the Reassign Services window. Click OK to add them to this 
domain.

Setting the Vantage Windows Log On ID for a Service
On the Lightspeed server, the default log on ID for each Vantage service is the Local 
System account. This log on ID provides access to files on the local server only. If a 
service requires access to files on another server, the Local System account cannot 
provide that access; rather, the service must be able to log onto the other server with an 
account the other server recognizes and grants privileges to. 

To give Vantage services access to input folders, output folders, Vantage stores or other 
files on another computer, you must do the following:

• Create a Vantage Windows user ID for the service

• Grant access on the target servers to the Vantage Windows user ID for the service.

For more information, see Windows Authentication Guidelines in the Domain 
Management Guide.

Within a single service, the Windows log on ID for that service must be the same on all 
Vantage servers in the domain. For example, all Analysis services within the domain 
must use the same log on ID. However, the Catalog service, which does not access files, 
can remain set to use the Local System account.

To change the log on ID for a Vantage service, do the following for that service on each 
Vantage server in the array:

1. In the Vantage Management Console, click Services in the left panel.

2. Select a service in the list (Shift-click or Ctrl-click to select multiple services). 
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3. Click the Change Service Logon button  or right-click and select Change Service 
Log On. A dialog opens, requesting the logon. 

4. Select Local System account to use the account currently accessing Vantage from 
your local machine, or select This account and fill in the user name and password for 
the account that has access to the desired network location. 

5. Click OK. A message confirms that the logon is changing.

Note: Changing a service logon restarts that service. Also note, when changing the 
logon for multiple services simultaneously, some services may not restart properly. If 
this occurs, go to Start > Services on the server, select the affected services, and click 
(or right-click) Restart to manually restart the services.

6. Grant file access to the new user on all Vantage servers that the service must access.

Removing the Vantage Domain Database
The Vantage Domain Database may or may not be present as a separate entry in the 
Windows Control Panel Programs and Features window, depending on how it was 
originally installed. 

In either case, the Domain Database can be removed using one of the following 
procedures:

If the Domain Database is present in the Control Panel list, remove it as follows:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

Control Panel > Programs and Features > Uninstall Programs.

3. Select Vantage Domain Database and click Remove or Uninstall.

If the Domain Database is not present in the Control Panel list, remove it as follows:

1. Log onto the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

Control Panel > Programs and Features > Uninstall Programs.

3. Select Vantage and click Change.

4. Deselect the check box for Vantage Domain Database and continue with removal. 



Upgrading and Modifying Vantage
Adding a Lightspeed Server to an Existing Vantage Domain

149

Removing Microsoft SQL Server
To remove Microsoft SQL Server, follow these steps:

1. Log into the server with a local administrator account.

2. Open the control panel tool to remove programs (Control Panel > Programs and 
Features > Uninstall Programs).

3. Remove Microsoft SQL Server as follows:

a. Select Microsoft SQL Standard and click Remove or Uninstall.
b. Click Remove.
c. Click OK.
d. Select the Vantage instance, and click Next.
e. Click Select All, and click Next.
f. Click Next.
g. Click Remove.
h. Click Next.
i. Click Close.

Note: If you are prompted to stop the SQL Server (VANTAGE) service, be sure to do so 
in the Services control panel, before proceeding by pressing Retry.

Note: If you have multiple instances (SQLSTANDARD and VANTAGE for example), you 
will need to remove them both.

4. Select Microsoft SQL Server Native Client and click Remove or Uninstall.

Note: Uninstalling the Vantage Domain Database or the SQL Server does not delete 
your Vantage domain database files containing your workflows, resources, and 
transaction history. It leaves those files intact in [Install_Drive]:\Program 
Files\Telestream\Vantage\Database. If you reinstall SQL and the Domain Database 
application later, you can attach these files and restore your previous Vantage domain.
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Removing Vantage

The following topics describe how to remove the Vantage software and associated 
third party software:

■ Uninstalling Vantage from a Server

■ Uninstalling Vantage Clients from a Workstation

■ Removing ComponentPacs
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Uninstalling Vantage from a Server
Each Vantage server may host some or all of the software components listed in the 
following procedure. You can use this procedure whether you are removing all of 
Vantage or individual components. 

To completely uninstall Vantage or to uninstall specific components, follow these steps:

1. Log into the server with a local administrator account.

2. In the Vantage Workflow Designer, stop all jobs.

3. In the Vantage Management Console, stop all services. Also if you intend to reinstall 
or upgrade Vantage, use the Backup function to save your domain database to a 
backup file. This protects your data in the event of a problem with re-installation. 
(You can skip this step if you are only removing the Web Applications.)

4. Open the Windows Control Panel and start the Uninstall Programs tool.

5. Using the Control Panel, right-click each of the following Vantage programs in the 
order listed below and select Uninstall to remove them:

• Vantage Web Applications

• Vantage update packs in reverse sequential order

• Telestream Media Transcode and Analysis engine

• Vantage 

• Vantage Domain Database

Note: Subsystems (IPP, QuickTime, etc.) that have been installed during Vantage 
installation are not removed, and Vantage domain data and media you have created 
are not removed.

Note: If your domain has a mirrored database server, be sure to disable mirroring and 
stop the SQL Server Agent service, before proceeding.

6. Use the Control Panel tool to remove Microsoft SQL Server Express or Standard:

a. Select Microsoft SQL Express or Microsoft SQL Standard and click Remove or 
Uninstall.

b. Follow the prompts until removal is complete.
c. Optional step—Click the refresh button in the Control Panel to update the 

display, which will clear some of the SQL Server components from the display.

7. In the Control Panel tool, select Microsoft SQL Server Native Client and click 
Remove or Uninstall.

Note: Uninstalling the database does not delete your Vantage workflows, resources, 
or transaction history. It leaves your database files intact in [Install_Drive]:\Program 
Files\Telestream\Vantage\Database. This allows you to re-attach a Vantage domain 
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database and return Vantage to a previous state when re-installing or upgrading 
Vantage. In the event of any problems, you also have the backup you created earlier.

8. To permanently delete all Vantage files, use Windows Explorer to delete the 
following directory:

[Install_Drive]:\Program Files (x86)\Telestream\Vantage

CAUTION: Deleting these files permanently destroys the Vantage domain database 
including the domain configuration, workflows, and history. If you created a backup 
file earlier using the Vantage Management Console or if you create one now, you can 
preserve the domain for re-installation later.



Removing Vantage
Uninstalling Vantage Clients from a Workstation

154

Uninstalling Vantage Clients from a Workstation
On workstations, the Vantage client programs are the Vantage Management Console 
and Vantage Workflow Designer. Vantage Workflow Portal (VWP) and Vantage Dublist 
Portal can also be installed on a workstation.

To completely uninstall Vantage from a workstation, follow these steps:

1. Open the Control Panel Uninstall Programs tool in your operating system:

2. If the Vantage client software is installed, select Vantage Client and click Remove or Uninstall.

3. If the Vantage Workflow Portal is installed, select Vantage Workflow Portal and click 
Remove or Uninstall.
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Removing ComponentPacs
To remove old ComponentPacs:

1. Open the Vantage Management Console, and click ComponentPac Management in 
the left column. Installed ComponentPacs are listed in the Installed 
ComponentPacs list on the right. 

2. Click the package you plan to uninstall and check the Actions panel for affected 
workflows and actions.

Export all workflows that reference the ComponentPac you want to uninstall (to 
back them up), and then delete the workflows in Vantage.

3. Click the Uninstall button in the ComponentPac Management window while the 
package to be removed is selected. 

Note: The Uninstall button appears only when a package is not used by any actions. 

4. After uninstallation completes, restart the affected Vantage services. If the 
Workflow Designer was open, close it and reopen to all the changes to take effect.

The selected old package is removed and no longer appears in the ComponentPac 
Management list.
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Troubleshooting Vantage 
Installation

Use this topic to install, upgrade, or scale Vantage, and configure it for operation.

Note: To obtain the Vantage installation software, go to www.telestream.net/
telestream-support/vantage/support.htm. At this same location, you can browse the 
Vantage Web library, user’s guides, application notes, and other documents.

The following topics describe how to install and upgrade Vantage components:

■ Troubleshooting Vantage Installation

■ Troubleshooting Vantage Web Applications

Troubleshooting Vantage Installation
Possible installation issues and solutions are explained in the following topics.

Database Deployment Utility

Action Templates and Schemes Do Not Work Correctly
If Vantage action templates and fulfillment schemes do not deploy properly, it may be 
because you assigned the Vantage services to the host name of the database server 
before using the Database Deployment Utility. 

To resolve this issue, use the Microsoft Services Console to restart the Vantage services 
after the database is deployed. Also close and reopen the Vantage Management 
Console and Workflow Designer. 

Verifying DTC Service Settings
During installation, Vantage configures and starts the Distributed Transaction 
Coordinator (DTC) Windows service. There is no need to verify DTC configuration and 
operation after the install, but if you suspect that the DTC service has stopped or the 

http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
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DTC configuration has changed, you can use the information in this topic to verify the 
DTC status and configuration.

Vantage uses DTC for communication between services and the SQL Server database to 
guarantee that messages are processed as atomic messages (that is, the entire message 
is successfully processed or the database state is reverted to the pre-message state). 
This guarantees that services do not duplicate jobs and that jobs do not register in a 
partial or incomplete state in the database. 

In a Vantage domain, DTC must be running and correctly configured on each Vantage 
database server and Vantage server, or Vantage services cannot communicate with the 
Vantage domain database, and the domain stops operation.

To verify operation and configuration, use the procedures in the following topics:

■ Verifying DTC Operation

■ Verifying the DTC Configuration

Verifying DTC Operation
To verify that the DTC is running, do the following:

1. In Windows, select Start > Administrative Tools > Services.

2. Verify or set the startup type for Distributed Transaction Coordinator to Automatic.

3. If you need to change the startup type, do the following:

a. Right-click on the Distributed Transaction Coordinator service and select 
Properties to display the Properties window.

b. Select Automatic from the Startup Type dropdown and click OK.

4. If the DTC service is not running, right-click on the service name and select Start.

Verifying the DTC Configuration
To verify that DTC is configured correctly, do the following:

1. In Windows, select Start > Administrative Tools > Component Services.

2. In the left panel, navigate to Component Services >Computers > My Computer > 
Distributed Transaction Coordinator. 

3. In the right panel, right-click Local DTC and select Properties.

4. Click the Security tab.
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5. To enable transactions to properly flow from one machine to another, set the 
Security configuration settings as shown in the figure below, and click OK.

Note: You have to restart the database instance in order for SQL to receive 
notification of the changes to the DTC. You can restart the database by restarting the 
server that the database is on.

License Cannot Be Activated Offline
Occasionally the Vantage Management License console may not allow you to activate a 
license offline. You can defeat the online licensing process and force the offline 



Troubleshooting Vantage Installation
Troubleshooting Vantage Installation

160

licensing window to appear by setting the Internet Explorer proxy to a false address as 
shown below or physically disconnecting the Internet from the computer. 

Now when you attempt to activate a license, you will see a dialog showing that there is 
no Internet connection. 

Click Cancel to open the product activation window. 

Now you can follow the manual activation process on this computer using the Internet 
connection and browser of another computer. See the Vantage Installation Guide or the 
Vantage Domain Management Guide > Installation chapter > Activating a Vantage 
License Offline topic for details about activating without an Internet connection to the 
Vantage computer.
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To activate your license with a different computer, do the following:

1. Click Cancel to continue. Vantage displays the Product Activation dialog:

Troubleshooting Vantage Web Applications
The following are some symptoms and remedies that apply to troubleshooting the 
installation of the Vantage Web Applications:

• Web Apps can’t be accessed by the browser or not all applications show up. 

Refresh the Vantage domain by clicking Change Domain in the upper right corner 
and selecting the desired domain from the list.

• If you experience any of the following issues, run the ASP.NET registration tool 
(aspnet_regiis.exe) to fix the .Net installation: 

– HTTP 500.19 error appears in the browser when you attempt to access the 
Vantage Web Applications after a new install.

– Your Web applications do not display correctly or do not allow you to log in.

– When running Vantage Web Applications Setup.exe, if the Select Installation 
Address page does not default to ASP.NET for the Application Pool AND if .NET 
Framework 4.8 is already installed, run the aspnet_regiis.exe registration tool and 
then run Vantage Web Applications Setup.exe again.

This is the Windows Command Prompt command to run aspnet_regiis.exe:

C:\Windows\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis.exe –i

Note that the path varies slightly depending on the Windows/.NET versions.

For more information about using aspnet_regiis.exe, refer to the Microsoft MSDN 
Web site.
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• In some browsers, the Web Workflow Portal preview player space bar may not func-
tion as expected to pause or play video. This functionality is part of the browser’s 
implementation of the media player. Try using different browsers to find the one 
that provides the best playback experience in your environment.

• The appearance of captions in the Web Workflow Portal preview player may vary 
depending on your browser. Try different browsers to find the one that best meets 
your needs.

• On occasion, when using the Web Workflow Portal preview player in Internet 
Explorer, if you jump to the end of a clip and then scrub backward followed by step-
ping forward, you may see a skew or jitter in the frame step capability. This is an 
artifact of the Internet Explorer HTML5 player.

• Telestream has occasionally observed the Web Workflow Portal media player dis-
playing an incorrect frame number even though the frame position is correct when 
playing to the end of a clip in the Chrome browser. If this anomaly is problematic, 
Telestream suggests switching to another supported browser.

• The Web Workflow Portal HTML5 preview player requires Windows Desktop Experi-
ence in order to run. Ensure that Desktop Experience is enabled and up-to-date. 

• When using the Web Workflow Portal in the Safari browser with the Copy Binder 
configuration, the Submit button does nothing when the user attempts to submit 
the portal configuration and a binder. Disabling Block Popup Windows in the Safari 
Preferences > Security > Web Content menu resolves this issue.
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